Release Notes for Cisco Customer Response Solutions 4.0(5/5a1)

December 15, 2008

These release notes describe new features, important information, and caveats for Cisco Customer Response Solutions (Cisco CRS) Release 4.0(5).

These release notes may be updated occasionally with new information. For the latest version of these release notes, and for other Cisco CRS documentation, go to this URL:


Before you install or upgrade Cisco CRS, review the “Installation, Upgrade, and Patching Notes” section on page 6 and the “Important Notes” section on page 9.

For a list of the resolved, open, and closed caveats for Cisco CRS 4.0(5), see the “Caveats” section on page 32.

1.CRS 4.0.5a is an updated version of CRS 4.0.5 that addresses an issue where an upgrade would fail if your cluster profile name is longer than 20 characters. In this document, please note that 4.0.5 refers to both 4.0.5 and 4.0.5a.
Contents

- Introduction, page 3
- Related Documentation, page 8
- Installation, Upgrade, and Patching Notes, page 6
  - Running the Pre-Upgrade Check Tool when Upgrading to Cisco CRS 4.0(x), page 6
  - Upgrading from CRS 3.x when CTI Ports Belong to More than One Device Pool, page 7
  - Upgrading from CRS 3.x when CTI Ports Belong to More than One Device Pool, page 7
  - Upgrading Microsoft SQL Server 2000, page 7
  - Installing a Patch on a Coresident Server, page 7
  - Hyperthreading Not Supported, page 8
- Important Notes, page 9
- Unsupported Configurations for Cisco CRS, page 20
- Unsupported and Supported Actions for Cisco IPCC Express Agents, page 21
  - Unsupported Actions for Cisco IPCC Express Agents, page 21
  - Supported Configurations for Agent Phones, page 22
  - Unsupported Configurations for Agent Phones, page 22
- Unsupported Features in Cisco CallManager, page 23
- Contact Dispositions in Cisco CRS Real-Time Reports and Historical Reports, page 24
- Cisco CRS Database Changes that affect Custom Historical Reports, page 25
- Adding a 15-Minute Interval Length to a Cisco CRS Historical Report Filter Parameter, page 30
- Caveats, page 32
  - Using Bug Toolkit, page 32
  - Resolved Caveats, page 34
  - Open Caveats, page 39
Introduction

The Cisco CRS platform provides a multimedia (voice, data, and web), IP-enabled customer-care application environment that enhances the efficiency of contact centers by simplifying business integration, easing agent administration, increasing agent flexibility, and enhancing network hosting.

Cisco CRS 4.0(5)

Cisco CRS 4.0(5) provides resolutions to important issues enhancements to the 3.x to 4.0(5) upgrade procedures. It also provides these updated documents:

- *Cisco CRS Installation Guide 4.0(5)*
- *Cisco CRS Servicing and Troubleshooting Guide 4.0(5)*
Cisco CRS 4.0(4)
Cisco CRS 4.0(4) provides resolutions to important issues. It also provides support for Citrix, and these updated documents:

- Cisco IPCC Express Edition Solution Reference Network Design
- Cisco CRS Installation Guide 4.0(5)

Cisco CRS 4.0(3)
Cisco CRS 4.0(3) provides resolutions to important issues. It also provides:

- Embedded browser for the Cisco Agent Desktop
- Cisco IP Phone Agent support for these Cisco IP Phone models:
  - Cisco IP Phone 7911
  - Cisco IP Phone 7920 (for additional information about using this phone model, refer to Cisco IPCC Express 4.0 Solution Reference Network Design (SRND))
  - Cisco IP Phone 7941
  - Cisco IP Phone 7961
- Cisco Agent Desktop and Cisco Supervisor Desktop support for these Cisco IP Phone models:
  - Cisco IP Phone 7911
  - Cisco IP Phone 7920 (for additional information about using this phone model, refer to Cisco IPCC Express 4.0 Solution Reference Network Design (SRND))
  - Cisco IP Phone 7941
  - Cisco IP Phone 7961
  - Cisco IP Phone 7985
Introduction

The following updated documents:
- Cisco CAD Installation Guide 6.1(1)
- Cisco CAD Service Information 6.1(1)
- Cisco Agent Desktop User's Guide 6.1(1)
- Cisco Desktop Administrator User's Guide 6.1(1)
- Cisco IP Phone Agent User's Guide 6.1(1)
- Cisco Supervisor Desktop User's Guide 6.1(1)
- Cisco CRS Servicing and Troubleshooting Guide 4.0(1)
- Cisco IPCC Express 4.0 Solution Reference Network Design (SRND)
- Cisco CRS Installation Guide 4.0(5)

Cisco CRS 4.0(2)
Cisco CRS 4.0(2) provides resolutions to important issues.

Cisco CRS 4.0(1)
Cisco CRS 4.0(1) provides a variety of new and enhanced features, including:
- Cluster-based architecture
- Enhanced installation procedure
- Enhanced administration and serviceability
- Optional high availability with automatic failover
- Increased maximum number of agents to 300
- Integration into Cisco Customer Interaction Network
- New ACD routing and related features
- Support for Cisco IP Phone 7970
- Support for Cisco Communicator
- Enhancements to the look and feel of the Cisco Agent Desktop and the Cisco Supervisor Desktop
- New and enhanced historical reports
- New automatic speech recognition (ASR) and text-to-speech (TTS) model
Installation, Upgrade, and Patching Notes

This section includes these topics:

- Running the Pre-Upgrade Check Tool when Upgrading to Cisco CRS 4.0(x), page 6
- Upgrading from CRS 3.x when CTI Ports Belong to More than One Device Pool, page 7
- Correcting CRS 3.x to Cisco CRS 4.0(5) Upgrade Error Caused by Incomplete Uninstallation of CRS 3.x, page 6
- Upgrading Microsoft SQL Server 2000, page 7
- Installing a Patch on a Coresident Server, page 7
- Hyperthreading Not Supported, page 8

Running the Pre-Upgrade Check Tool when Upgrading to Cisco CRS 4.0(x)

The Cisco CRS 4.0(5) Installation Guide describes where to obtain the Cisco CRS 4.0 Pre-Upgrade check tool and when to use this tool. To run tool, follow these steps:

1. Download the tool to the server on which the Cisco CRS Engine is installed.
2. Launch the .exe file that you download and wait until it completes the extraction of the files and launches the tool.
3. When the tool starts, follow the on-screen instructions.

Correcting CRS 3.x to Cisco CRS 4.0(5) Upgrade Error Caused by Incomplete Uninstallation of CRS 3.x

If you encounter an error when upgrading from Cisco CRS 3.x to CRS 4.0(5) and you determine that the error was caused by an incomplete uninstallation of the 3.x software (because, for example, you omitted an upgrade step or provided an incorrect response to a prompt), perform the following steps. This procedure assumes that you have successfully performed Step 1 through Step 16 in the
“Upgrading the Cisco CRS Software” section in the “Upgrading Cisco CRS 3.x to Cisco CRS 4.0(5)” chapter in Cisco Customer Response Solutions 4.0(5) Installation Guide. In this case, you should have a backup file that is saved in a location other than the CRS server.

4. On the CRS server that is having the upgrade problem, re-install the operating system and re-image the operating system partitions.

5. Configure the re-imaged server with the same host name and IP address that it had originally.

6. Follow the procedure in “Replacing the Cisco CRS Server” section in the “Upgrading the Cisco CRS Software”, starting from Step 2.

### Upgrading from CRS 3.x when CTI Ports Belong to More than One Device Pool

If you are upgrading from Cisco CRS 3.x and the CTI ports in any CTI port group belong to more than one device pool, make sure to add all of the device pools in the CRS 4.0(5) Data Migration page during the upgrade procedure.

### Upgrading Microsoft SQL Server 2000

If you are using Microsoft SQL Server 2000, you must use the disk provided by Cisco to upgrade to the current version of this application when you upgrade to Cisco CRS 4.0(5). For instructions, see the MS SQL Server 2000 for Cisco Customer Response Solutions Resources Card.

### Installing a Patch on a Coresident Server

After installing a patch on a coresident server (a server on which both Cisco CRS and Cisco CallManager are installed), you may see a “Patch” error message when starting the Cisco CRS Administration application. To avoid this issue, after you complete the patching procedure, rerun the BARS and restore the patch file again.
Hyperthreading Not Supported

Hyperthreading is not supported by Microsoft Windows 2000 and 2003 and is disabled by default in Cisco-provided operating systems.

Related Documentation

Table 1 provides references to related documentation. In addition, you can obtain online help from the Cisco CRS Administration web pages, the Cisco CRS Editor, the Cisco Agent Desktop, the Cisco Supervisor Desktop, the Cisco Desktop Administrator, and the Cisco CRS Historical Reports client interface.

Note If a Cisco CRS document is not updated from a previous release of Cisco CRS, that document remains valid for the current release.

<table>
<thead>
<tr>
<th>Related Information and Software</th>
<th>Document or URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco CRS documentation overview</td>
<td><em>Cisco Customer Response Applications 4.0 Resources Card</em> in your Cisco CRS product package</td>
</tr>
</tbody>
</table>
**Important Notes**

This section provides important information that might have been unavailable upon the initial release of documentation for Cisco CRS 4.0(5).

- **Upgrading Cisco CRS when cluster profile name is longer than 20 characters**—If you are upgrading to Cisco CRS 4.0(5) and the cluster profile name is longer than 20 characters, an error message appears. (You can determine the cluster profile name from the Cisco CRS Administration application by choosing **System > LDAP Information** and looking at the Profile Name field.) To workaround this issue:
  - If you are upgrading from Cisco CRS 3.x to 4.0(5), change the cluster profile name to be 20 characters or less.
  - If you are upgrading from Cisco CRS 4.0(x) to 4.0(5), perform the upgrade using Cisco CRS 4.0(5a), which will be available beginning on February 9, 2007.

- **Supported products**—For current information about supported products for Cisco CRS, refer to **Cisco Customer Response Solutions (CRS) Software and Hardware Compatibility Guide**, which is available at this URL:
Creating Custom Historical Reports for Cisco CRS 4.0(5) SR1 with ES9, Cisco CRS 4.0(5) SR2 or later—Cisco CRS 4.0(5) SR1 with ES9, Cisco CRS 4.0(5) SR2 or later ship with the same version of Crystal Reports DLLs as in Cisco CRS 5.0(1). Hence, the process to create custom reports is also the same as in Cisco CRS 5.0(1). For detailed information on creating a report, refer to Cisco Customer Response Solutions 5.0(1) Historical Reporting Administrator and Developer Guide available at this URL: http://www.cisco.com/en/US/docs/voice_ip_comm/cust_contact/contact_center/crs/express_5_0/programming/hr_admin_devp/crs501hd.pdf

Upgrading Client Applications when Upgrading Cisco CRS—When you upgrade from Cisco CRS 3.x to Cisco CRS 4.0(5), you also must upgrade Cisco Agent Desktop, Cisco Supervisor Desktop, and Cisco CRS Historical Reporting applications, if you are using these applications. To do so, you must have administrator privileges that allow you to install applications and suspend virus and intrusion detection software on the servers on which these applications are running. For additional information, refer to Cisco CAD Installation Guide and to Cisco Customer Response Historical Reports User Guide.

Third-party software might affect performance and support—Adding third-party software to a Cisco CRS system may affect how Cisco CRS functions and may affect Cisco’s support for Cisco CRS. Such third-party software includes Microsoft critical security updates, anti-virus software, and other non-required third-party software. Also, make sure to read and accept the license agreement that comes with a third-party product. For information about Cisco’s policy regarding third-party software, refer to this URL: http://www.cisco.com/en/US/products/sw/custcosw/ps1844/prod_bulletins_list.html

Active Directory integration might affect performance—If you are integrating Cisco CRS with Active Directory, refer to the caveat CSCsb20774 for details about how you might be affected and for workarounds. To access this caveat, see the “Using Bug Toolkit” section on page 32.
Important Notes

- **Deployment on MCS-7835-I1, MCS-7845-I1, or IBM xSeries-346 server**—If you are deploying an MCS-7835-I1, MCS-7845-I1, or IBM xSeries-346 server, refer to the field notice Some Cisco Media Convergence Server (MCS) Encounter Network Interface Card (NIC) Numbering Reversal, which is available at this URL:
  

- **Policy Changes in New Zealand Daylight Savings Time**—To know about the policy changes in New Zealand daylight savings time and to understand the impact on Unified CCX, refer to the field notice FN-62880 - New Zealand Daylight Savings Time Policy Changes Effective September 2007 - For Cisco Unified Contact Center Express (Unified CCX), which is available at this URL:
  

- **Moving a node to another subnet might affect performance**—If you move Cisco CRS nodes to another subnet, you may experience the following issues:
  - You cannot configure resource, skills, and so on
  - The MADM error log contains the message `[Microsoft][ODBC SQL Server Driver][SQL Server][OLE/DB provider returned message: New transaction cannot enlist in the specified transaction coordinator.]`

  To work around this situation, check network connectivity, and add names to the hosts file.

- **Requirements for location of Cisco CRS Engine and Database components**—The Cisco CRS Engine and Database components, in deployments with or without high availability, must be located in the same campus LAN and the round-trip delay between these servers should be less than 2 ms. The links between these servers must be highly available and the available bandwidth should always be considerably higher than the load, and there should be no steady-state congestion.

- **HA Licensing Requirements**

  **Note** You need a WARM STANDBY license to enable the standby server.
When you apply the licenses to the first or active node in the cluster, the license files get uploaded to the LDAP server in the central repository. The license configuration applies to the cluster, that is, to all machines in the cluster. This implies that if you have uploaded the WARM STANDBY license to the repository, then when you add a standby server to the cluster, it would use the same profile or repository to get the license files and you do not need to apply the same license files again to the standby server.

**Note**

There is no separate license required for expansion server. However, the Recording and Monitoring services are enabled only with the ENH and PRE licenses.

If your license has HA capability, then the license file will contain a WARM_STBY feature line in it. For example, for Premium Servers, it would be CRS_EXP_PRE_WARM_STBY.

- **Redirection to translation patterns not supported**—CRS does not support the use of consult transfer/redirect step from scripts to a translation pattern that maps back to a route point.

- **Password aging restrictions**—Password aging is a Microsoft Active Directory feature that you can enable when Cisco CallManager is integrated with Active Directory. Do not enable this feature for any of the “system” Cisco CallManager user accounts, including the JTAPI provider user, the RMJTAPI provider user, or the telecaster user that is associated with the Cisco Desktop IP Phone Agent service. If you enable this feature but do not change the password for one of these Cisco CallManager users before the password expires, the following issues will occur:
  - JTAPI provider user—Calls to Cisco CRS route points will not be processed
  - RMJTAPI provider user—Agents will not be able to login to the Cisco Agent Desktop or the Cisco IP Phone Agent
  - Cisco IP Phone Agent user—Agents will be unable to use the Cisco IP Phone Agent

- **Scheduled historical reports might not run when using a proxy service**—If you are using a proxy service in Internet Explorer on the CRS Historical Reports client system, scheduled historical reports might not run and you might see this message in the CiscoSch.log file: `[CRA_DATABASE] entry not found in the properties file` followed by `failed to`
Important Notes

validate user OR get MaxConnections of database value. If this situation occurs but you can run the report directly from the CRS Historical Reports client system, follow these steps:

a. From Internet Explorer on the Historical Reports client system, choose Tools > Internet Options.

b. Click Connections.

c. Click LAN Settings.

The Use a Proxy Service check box will be checked if you are using a proxy server.

d. Click Advanced.

e. In the Do not use proxy server for addresses beginning with field, enter the IP address of the Cisco CRS server that the Historical Reports client system logs in to.

f. Click OK as needed to save your changes.

• “Administrator” is required Windows account username—The only supported username for the Windows account on a server that is running Cisco CRS is Administrator. If you use another user name, the CRSAdminUtil.exe tool might not work properly.

• Microsoft DTC requirements—The Microsoft Distribution Transaction Coordinator (DTC) requires that your system be able to resolve computer names by NetBIOS or DNS. You can test whether NetBIOS can resolve the names by using ping and the server name. The client computer must be able to resolve the name of the server and the server must be able to resolve the name of the client. If NetBIOS cannot resolve the names, you can add entries to the LMHOSTS files on the computers.

For additional information, refer to article number 250367 in the Microsoft online help and support knowledge base.

• Cisco CallManager hardening procedure causes Cisco CRS configuration failure—CRS configuration fails if you perform the Cisco CallManager operating system hardening procedure using the scripts provided in the C:\utils\SecurityTemplate folder. This situation occurs because the scripts disable IIS and Tomcat services on Cisco CallManager subscribers, which affects the subscribers on which CTIManager is running. (These subscribers are designated by the IP address input for the JTAPI provider.)
To workaround this situation, reenable these services on the subscribers.

- **Updating JTAPI and RMJTAPI users**—To update JTAPI and RMJTAPI users in Microsoft Active Directory, perform the procedure that is described in the “Setting the Access Control Lists for Active Directory” section in *Installing the Cisco Customer Directory Configuration Plugin for Cisco CallManager Release 4.1(3)*. This document is available at this URL: [http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_installation_guide09186a00803f5c06.html](http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_installation_guide09186a00803f5c06.html)

  Perform this procedure on all servers that are specified in the Cisco CRS Administration JTAPI Provider list. In this way, Cisco CRS is able to communicate with Microsoft Active Directory via the AVVID XML Layer (AXL) interface.

- **ASR/TTS provider becomes IN-SERVICE prematurely**—If you delete an ASR/TTS provider and all of its associated servers, and then create a new ASR/TTS provider, its status might become IN_SERVICE immediately, even before you create any servers for it. In this situation, click Refresh for that ASR/TTS provider, or click Refresh All. These actions change the status of the ASR/TTS provider to OUT_OF_SERVICE.

- **Agent not deleted automatically when not in LDAP**—An agent is no longer automatically deleted from the Cisco CRS database when Cisco CRS detects that the agent no longer exists in LDAP. Instead, the Cisco CRS Administration Resources page includes a new link called Inactive Agents. When you click this link, Cisco CRS displays a list of agents that do not exist in LDAP but that do exist in the CRS database. In this case, you can select certain agents to delete from Cisco CRS by checking the check box next to each agent, or you can select all agents for deletion by clicking Check All. Then click Delete to remove the selected agents from the Cisco CRS database. Until you follow this procedure, agents that no longer exist in LDAP continue to appear in the list of agents in Resources page, but they are unable to log in because the LDAP authentication is not successful. For more information, refer to *Cisco CRS Administration Guide*.

  **Note** If LDAP errors or errors connecting to the LDAP server occur when you display the list of inactive agents, this list might not be accurate. When the errors are resolved, click Inactive Agents again to see an accurate list.
• **Custom report fails with the “Invalid name” error**—Attempting to generate a scheduled custom report fails with the error “Invalid name” when the showUserNameOnReport parameter is set to 1 in the Historical Reports hrcConfig.ini file. To work around this problem, add the label @UserName to the .rpt report file that you create with Crystal Reports. To determine where to place this attribute, look at the definition file for any of the Cisco-provided historical reports.

• **Historical Reports Client version must match Cisco CRS version**—If you are using Cisco CRS Historical Reports client software, it must be the same version as the version of Cisco CRS that you are running.

• **Cisco CallManager Publisher should be the first entry in the list of LDAP servers**—Before you upgrade from Cisco CRS 3.x or 4.0(x) to Cisco CRS 4.0(5), make sure that the Cisco CallManager Publisher is the first entry in the list of LDAP servers in the Cisco CRS Administration Directory Configuration page, as described in the “Installation and Upgrade Notes” section in *Cisco CRS Installation Guide*.

  To designate the list of LDAP servers for Cisco CRS 3.x, choose **System > Configuration and Repository** from Cisco CRS Administration to display the Directory Setup page. Click the **Configuration** link on the Directory Setup page and make any necessary changes. Then click the **Repository** link on the Directory Setup page and make any necessary changes. For more information, refer to Cisco CRS Administration Guide.

  To designate the list of LDAP servers for Cisco CRS 4.0(x), choose **System > LDAP Information** from Cisco CRS Administration to display the CRS LDAP Server Information page. For more information, refer to *Cisco CRS Administration Guide*.

  In addition, when you perform the upgrade, make sure that the IP address or the host name of the Cisco CallManager Publisher appears as the first entry in the “Enter LDAP server host name, IP address, or AD domain” field in the LDAP Server Information window. If the IP address or the host name of the Cisco CallManager Publisher does not appear as the first entry in this field, correct it manually.

• **ECC variable names should begin with “user”**—To ensure that variable data is handled properly, make sure that every user-defined Expanded Call Context (ECC) variable name begins with “user.”
• **Making configuration changes after failover**—If a node goes down in a high-availability Cisco CRS deployment, you cannot make configuration changes in Cisco CRS Administration. To work around this issue, take these actions:

  - Make sure the active node is the publisher. If it is not, use Cisco CRS Administration to make it the publisher for all datastores.
  - From the Component Activation page in Cisco CRS Administration, deactivate the Config Datastore and the Historical Datastore for the inactive node.

• **Configuring Cisco IP Communicator**—For information about configuring Cisco IP Communicator for use with Cisco CRS, refer to the following documents:

  - Cisco IP Communicator Administration Guide (2.0)
  - Install and Configure IP Communicator with CallManager 4.x

• **Size of Repository Datastore**—The Repository Datastore (named database db_cra_repository) stores user prompts, grammars, and documents files. The maximum total size of all files and folders that are stored in the Repository Datastore on a MCS with a 72 GB hard disk is 1.5 GB. This limitation applies even though the size of the Repository Datastore on a server with a 72 GB hard disk is 3 GB.

• **Using the CAD with Citrix or Microsoft Terminal Services**—IPCC Express 4.0(5) supports the running of the Cisco Agent Desktop (CAD) within a Citrix or Microsoft Terminal Services environment. For more information, refer to:

- **AAR manifest file**—The AAR manifest file must be in UTF-8 format.

- **Activating a second Cisco CRS Engine Component**—To activate a second server on which you installed the Cisco CRS Engine component in a deployment in which Cisco CallManager is integrated with Microsoft Active Directory, perform the following steps.

  (If you are attempting to activate the component using the Cisco CRS server setup procedure, you can ignore this message that appears on the Component Activation Results page: JTAPI information is not created properly, please use JTAPI Resynchronize option in JTAPI pages to fix the issues. Perform the following steps after you complete the server setup procedure.)

  a. From the Cisco CRS Administration application, choose **System > Control Center**, and make a note of the ID of the server on which you are activating the component.

  b. Choose **Subsystems > JTAPI > JTAPI Provider** and make a note of the User Prefix.

  c. Create a new user in Microsoft Active directory.

     The user name should be `JTAPI-user-prefix_node-id`. Replace `JTAPI-user-prefix` and `node-id` with the values that you noted.

     The password should be the same as the JTAPI user on the existing Cisco CRS Server.

  d. From the Cisco CRS Administration application, choose **Subsystems > JTAPI > Resynchronize**, and then click **Synchronize**.

- **SQL with Mixed Mode Authentication**—Cisco CRS does not support the use of Mixed Mode authentication for internal SQL with MSDE or SQL 2000.

- **MSDE or MS SQL 2000 Use**—If your Cisco CRS system will handle a high volume of calls, use the IPCC Express and IP IVR Configuration and Ordering Tools, available at the following URL, to determine whether MSDE or MS SQL 2000 is the suitable database for your installation.

• **Guidelines for entries in JTAPI CTI Port Group Migration page**—Entries in the following fields in the JTAPI CTI Port Group Migration page in Cisco CRS Administration must follow the guidelines for the corresponding fields in Cisco CallManager Administration. For information about these guidelines, refer to the Cisco CallManager documentation.
  - Description
  - Display
  - External Phone Number Mask

• **Link to Documentation**—The Help page in Cisco CRS Application Administration now includes a link called **CRS Documentation on Cisco.com**. This link provides access to the Cisco CRS documentation.

• **CRS 3.x system workflows not migrated**—Workflows that were installed by Cisco CRS 3.x serve a variety of purposes. Some, such as rm.aef and cm.aef, are required for system functionality. Others, such as aa.aef and icd.aef, provide examples of system capabilities. If you modify any system workflow for your use, make sure to save it under a different name. Sample scripts are not propagated when you upgrade Cisco CRS. If you do not rename a script, you will lose your changes when you perform an upgrade.

• **Changing LDAP**—If you change the LDAP for your installation (for example, if you change from DC-Directory to Microsoft Active Directory), you must use Cisco CRS Application Administration to reconfigure your Cisco CRS data.

• **CRS Editor is not backward compatible**—You cannot edit a workflow with a version of the Cisco CRS Editor that is older than the version that you used to create the workflow.

• **VAD should not be enabled when ASR is used**—When setting up a system that supports automatic speech recognition (ASR), Voice Activity Detection (VAD) should not be enabled anywhere in the network in which voice traffic will be transmitted if that traffic is routed to a Cisco CRS server with ASR.

• **Unsupported BARS release**—Installing BARS 4.0(9) SR1 install is not supported on a Cisco CRS server that is configured as a BARS target.
• **SQL replication issues**—If SQL replication is enabled through the Enterprise Manager, extra columns are added to tables in the db_cra database. Because of these extra columns, the following message appears when you attempt to make configuration changes such as changing or adding skills, resource group, or CSQs:

There was an error reading/updating the database. Please contact your administrator.

To workaround this issue, restore the system from a good backup or reinstall Cisco CRS server with MS SQL Server 2000.

• **Installing older CRS release is not supported**—You cannot install a release of Cisco CRS that is older than the release that you currently have installed.

• **Require Secure Channel [ssl] prevents access to JTAPI subsystem options**—If Require Secure Channel [ssl] is enabled on the Cisco CallManager server and you choose an option in the JTAPI subsystem, you are asked for Cisco CallManager authentication, but the operation fails even if you enter the proper authentication. To avoid this issue, follow these steps on the Cisco CallManager server:
  - Choose Programs > Administrative Tools > Internet Information Services (IIS) Manager.
  - Under Internet Information Services, expand the entry for the Cisco CRS node.
  - Right-click Default Web Site and choose Properties.
  - Click the Directory Security tab and click Edit in the Secure communications area.
  - Uncheck the Require Secure Channel [ssl] check box.
  - Click OK as needed to close the windows.

• **Unable to make modifications to the Cisco CRS cluster**—If you are unable to upload new prompts, modify teams, or make other similar configuration changes in a Cisco CRS cluster that is integrated with Microsoft Active Directory, a BARS backup may have failed or the patching process may have failed. In this case use the ADSIEDIT.MSC tool to edit the LDAP repository and append “?Empty” to Modify archiveID, archiveRequest, archiveTimestamp, and archiveUserInfo.
• **Configuring call forwarding for route points if Cisco CRS is down**—If you need to change the call forwarding configuration for route points when Cisco CRS is not operating, use the Forward on Unregistered option in Cisco CallManager administration.

• **Copyright date for Cisco CRS Administration Application**—The copyright date in the About > Help page that you access through Cisco CRS Administration should show the range of 1999–2007.

• **Operating System Language Supported on the Cisco CRS Historical Reports client**—The Cisco CRS Historical Reporting client supports the following operating system languages, which you configure by choosing Start > Settings > Control Panel > Regional Options:
  - de_DE (German)
  - en_US (United States English)
  - es_ES (Colombian Spanish)
  - fr_FR (French)
  - it_IT (Italian)
  - ja_JP (Japanese)
  - zh_CN (Simplified Chinese)

• **Database authentication and external connections**—The Cisco CRS db_cra database now uses windows authentication instead of mixed mode authentication. In addition, connections to external databases, other than those of supported wallboards, are not supported.

• **End points not supported in hunt groups**—Do not assign agent phones, CTI ports, or route points that are used by Cisco CRS to hunt groups.

---

**Unsupported Configurations for Cisco CRS**

Cisco CRS 4.0(5) does not support the following configurations:

• Shared lines for CTI ports and for CTI route points.

• Enabling the multilevel precedence and preemption (MLPP) flag in Cisco CallManager Administration.
Unsupported and Supported Actions for Cisco IPCC Express Agents

This section outlines the unsupported and supported actions for agents using the Cisco Agent Desktop or the Cisco IP Phone Agent Service. Agents can access similar information in the Cisco Agent Desktop online help.

Unsupported Actions for Cisco IPCC Express Agents

Use of the following softkeys on a Cisco IP Phone is not supported:

- Barge
- cBarge
- DirTrfr
- GPickup
- iDivert
- Join
- MeetMe
- Park
- Pickup

A call from a CRS route point cannot be redirected to a redirect destination that matches any CRS route point, if the call will not be delivered back to CRS.
Supported Configurations for Agent Phones

To determine the phone devices that are supported by the Cisco Agent Desktop and for use by Cisco IP Phone Agents, refer to Cisco Customer Response Solutions (CRS) Software and Hardware Compatibility Guide, which is available at this URL:


- An IPCC Express extension configured on a single device (but not on multiple devices).
- An IPCC Express extension configured in a single device profile (but not in multiple device profiles).
- Multiple agents sharing the same IPCC Express extension, which you can set up as follows:
  a. Configure the IPCC Express extension on a single phone (not in a device profile).
  b. Associate that phone with each agent who will use that extension.
  c. Select the appropriate directory number (DN) as the IPCC Express extension for each agent.

In this configuration, only one agent at a time can be logged in.

Note: All agents that currently have the IPCC Express extension to be shared must log out before you can configure additional agents to share that extension.

Unsupported Configurations for Agent Phones

The following configurations are not supported for agent phones:

- Two lines on an agent’s phone that have the same extension but exist in different partitions.
- An IPCC Express extension assigned to multiple devices.
• Configuring the same IPCC Express extension in more than one device profile, or configuring the same IPCC Express extension in any combination of device profiles and devices. (Configuring an IPCC Express extension in a single device profile is supported.)

• In the Cisco CallManager Administration Directory Number Configuration web page for each IPCC Express line, setting Maximum Number of Calls to a value other than 2.

• In the Cisco CallManager Administration Directory Number Configuration web page for each IPCC Express line, setting Busy Trigger to a value other than 1.

• Configuring a Cisco IP Phone with Secure Real-Time Protocol (SRTP) on.

• No Cisco Call Manager device can be forwarded to the IPCC Express extension of an agent.

• The IPCC Express extension of an agent cannot be configured to forward to a Cisco CRS route point.

• Use of characters other than the numerals 0–9 in the IPCC Express extension of an agent.

Unsupported Features in Cisco CallManager

The following Cisco CallManager features are not supported by Cisco CRS 4.0(5). These features are disabled by default and should not be enabled for Cisco CRS. For more information about these features, refer to the Cisco CallManager documentation.

• Block External to External Transfer.

• Drop Adhoc Conference When Creator Leaves.

• Q Signalling (QSIG) Path Replacement (PR).

This feature must be disabled when Cisco CRS is deployed. To disable this feature, set the Cisco CallManager service parameters Path Replacement Enabled and Path Replacement on Tromboned Calls to False.
Contact Dispositions in Cisco CRS Real-Time Reports and Historical Reports

The following notes help clarify information regarding contact dispositions on various Cisco CRS real-time reports and historical reports.

  
  Because these features can be enabled per route pattern, they should be turned off for all route patterns in the Cisco CallManager cluster that Cisco CRS might use. Enabling these features for route patterns that Cisco CRS does not use will not affect Cisco CRS.

  In addition, do not use Cisco CallManager Administration to add or change CTI ports or route points that are used by Cisco CRS.

Contact Dispositions in Cisco CRS Real-Time Reports and Historical Reports

Many real-time and historical reports show the disposition of a call. The Contact Service Queue Activity Report (by CSQ or by Interval) shows calls as Handled, Abandoned, and Dequeued. The Contact Service Queue Activity Report shows calls as Handled, Abandoned, Dequeued, and Handled by Other.

- A contact that is queued and answered by an agent shows as handled in real-time and in historical reports.

- A contact that is queued but abandoned before it is answered by an agent is shown as handled in the Overall IPCC Express Stats real-time report if a SetContactInfo step in the workflow marks the call as handled. The call is shown as abandoned otherwise. The CSQ IPCC Express Stats report shows the call as abandoned if it does not consider the SetContactInfo step.

  For more information about the SetContactInfo step, refer to Cisco CRS Scripting and Development Series: Volume 2, Editor Step Reference Guide.

- The historical CSQ reports take into account whether a contact is marked as handled by the SetContactInfo step to determine if a contact is dequeued. The CSQ IP IPCC Express Stats report does not consider the SetContactInfo step. Therefore, if a call is queued, then marked as handled, and then disconnects, the historical CSQ reports shows the call as dequeued on the CSQ Activity
Cisco CRS Database Changes that affect Custom Historical Reports

This section describes changes that were made to the CRS database tables for CRS 4.0(x). It includes information that you should review if you have created custom reports in CRS 3.x and you want to continue using these reports after you upgrade to CRS 4.0(x).

This section uses the following abbreviations for database tables:

- CCD—for ContactCallDetail
- CRD—for ContactRoutingDetail
- CQD—for ContactQueueDetail
- ACD—for AgentConnectionDetail
- CSQ—for ContactServiceQueue

Changes to database tables for CRS 4.0(x) include:

- ContactCallDetail table moved from the db_cra_ccdr database to the db_cra database.
- ContactQueueDetail table added to store individual contact service queue (CSQ) information. Now information for more than three CSQs can be stored.
- ContactRoutingDetail table no longer stores individual CSQ information. It now stores overall queuing information. Information for individual CSQs moved to CQD.
- NodeID added to CCD, CRD, CQD, and ACD.
- CRD, CQD, and ACD tables now include qIndex. Corresponding records should be joined on qIndex for conference to route point.

Table 2 provides information that you should review if you have created custom historical reports that you want to continue using after you upgrade Cisco CRS.

**Table 2  Information for Custom CRS Historical Reports**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Comments</th>
<th>Cisco CRS 3.x Usage Notes</th>
<th>Cisco CRS 4.0 Usage Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the CCD (ContactCallDetail) table in a custom report.</td>
<td>Cisco CRS 3.x stores the CCD table in the db_cra_ccdr database. Cisco CRS 4.0(x) stores it in the db_cra database.</td>
<td>Use either of these statements: select * from db_cra_ccdr.. ContactCallDetail or select * from db_cra_ccdr.dbo. ContactCallDetail</td>
<td>Use this statement select * from db_cra.dbo. ContactCallDetail</td>
</tr>
</tbody>
</table>
Cisco CRS Database Changes that affect Custom Historical Reports

### Table 2  Information for Custom CRS Historical Reports

<table>
<thead>
<tr>
<th>Activity</th>
<th>Comments</th>
<th>Cisco CRS 3.x Usage Notes</th>
<th>Cisco CRS 4.0 Usage Notes</th>
</tr>
</thead>
</table>
| Using the ContactRoutingDetail (CRD) table in a report to show CSQ information. | Cisco CRS 3.x stores queue information for up to 3 CSQs in the CRD table.  
CRS 4.0(x) stores overall queue information in the (CRD) table, and stores information for an unlimited number of individual CSQs in a new table called ContactQueueDetail (CQD). | Calls presented:  
CSQ recordID is stored in CRD.primaryCSD, CRD.CSD1, CRD.CSD2, or CRD.CSD3.  
CRD.primaryCSD is the CSQ that handled the call. The other fields indicate the CSQs to which the call was presented, but not handled.  
For example:  
CRD.primaryCSD = 1  
CRD.CSD1 = 2  
CRD.CSD2 = 3  
CRD.CSD3 = 4  
The call is presented to CSQs with recordIDs of 1, 2, 3, and 4. It is handled by the CSQ with recordID 1. | CSQ recordID is stored in CQD.targetID, where CQD.targetType = 0.  
For total calls presented to each CSQ recordID, use:  
select targetID, count(*)from ContactQueueDetail where targetType = 0  
group by targetID |
Using the ContactRoutingDetail (CRD) table in a report to show CSQ information *(continued).*

<table>
<thead>
<tr>
<th>Activity</th>
<th>Comments</th>
<th>Cisco CRS 3.x Usage Notes</th>
<th>Cisco CRS 4.0 Usage Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Calls handled:</td>
<td>For total calls handled by each CSQ, use:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The CSQ recordID that</td>
<td>select targetID, count(*)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>handled the call is stored</td>
<td>from ContactQueueDetail</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in CRD.primaryCSD. If</td>
<td>where targetType = 0 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the value of this recordID</td>
<td>disposition = 2 group by targetID.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>is –1, no CSQ handled the</td>
<td>You can also join CQD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>call.</td>
<td>with CCD to check that</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CCD.contactDisposition</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>= 2, and you can join CQD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>with ACD to check that</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ACD.talkTime is</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>non-zero.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calls abandoned:</td>
<td>For total calls abandoned</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The CSQ recordID from</td>
<td>from each CSQ: select</td>
</tr>
<tr>
<td></td>
<td></td>
<td>which the call is</td>
<td>targetID, count(*)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>abandoned is stored in</td>
<td>from ContactQueueDetail</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CRD.CSD1, CRD.CSD2, or</td>
<td>where targetType = 0 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CRD.CSD3. CCD.contactDisposition</td>
<td>disposition = 1 group by targetID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>should be 1.</td>
<td></td>
</tr>
</tbody>
</table>

Table 2  Information for Custom CRS Historical Reports
Using the ContactRoutingDetail (CRD) table in a report to show CSQ information (continued).

Calls dequeued:

**Scenario 1:** Call is handled by a script and dequeued from all CSQs that it was queued for.

The CSQ recordID is stored in CRD.CSD1, CRD.CSD2, or CRD.CSD3. CRD.primaryCSD should be –1, and CCD.contactDisposition should be 2 (handled). ACD should not be present, or ACD.talkTime = 0 (ring-no-answer).

**Scenario 2:** Call is handled by one of the CSQs and dequeued from all the others.

The CSQ recordID is stored in CRD.CSD1, CRD.CSD2, or CRD.CSD3. CRD.primaryCSD is the recordID of the CSQ that handled the call. ACD should be present, with talkTime not equal to zero.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Comments</th>
<th>Cisco CRS 3.x Usage Notes</th>
<th>Cisco CRS 4.0 Usage Notes</th>
</tr>
</thead>
</table>
| Using the ContactRoutingDetail (CRD) table in a report to show CSQ information (continued). | Calls dequeued: **Scenario 1:** Call is handled by a script and dequeued from all CSQs that it was queued for. The CSQ recordID is stored in CRD.CSD1, CRD.CSD2, or CRD.CSD3. CRD.primaryCSD should be –1, and CCD.contactDisposition should be 2 (handled). ACD should not be present, or ACD.talkTime = 0 (ring-no-answer). **Scenario 2:** Call is handled by one of the CSQs and dequeued from all the others. The CSQ recordID is stored in CRD.CSD1, CRD.CSD2, or CRD.CSD3. CRD.primaryCSD is the recordID of the CSQ that handled the call. ACD should be present, with talkTime not equal to zero. | For total calls dequeued from each CSQ: select targetID, count(*) from ContactQueueDetail where targetType = 0 and disposition in (3, 4, 5) group by targetID.
Adding a 15-Minute Interval Length to a Cisco CRS Historical Report Filter Parameter

The following Cisco CRS historical reports provide filter parameters that let you display information for 30-minute intervals or for 60 minute intervals within the report period.

- Contact Service Queue Activity Report (by CSQ)
- Contact Service Queue Activity Report (by Interval)

### Table 2: Information for Custom CRS Historical Reports

<table>
<thead>
<tr>
<th>Activity</th>
<th>Comments</th>
<th>Cisco CRS 3.x Usage Notes</th>
<th>Cisco CRS 4.0 Usage Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joining CCD, CRD, ACD on sessionID, sessionSeqNum, and profileID.</td>
<td>For CRS 4.0(x) multi node deployments, you must to join the tables on nodeID.</td>
<td>Use this statement: select * from CCD, CRD where CCD.sessionID = CRD.sessionID and CCD.sessionSeqNum = CRD.sessionSeqNum and CCD.profileID = CRD.profileID</td>
<td>Use this statement: select * from CCD, CRD where CCD.sessionID = CRD.sessionID and CCD.sessionSeqNum = CRD.sessionSeqNum and CCD.profileID = CRD.profileID and CCD.nodeID = CRD.nodeID</td>
</tr>
<tr>
<td>Joining CRD and ACD to display CSQ and agent information.</td>
<td>In CRS 4.0(x), a new table called ContactQueueDetail is created to store CSQ information for individual CSQs. In addition, CQD and ACD join on qIndex to identify the agent that handled a call when the call is conferenced to a route point.</td>
<td>Use this statement: select * from CRD, ACD where CRD.sessionID = ACD.sessionID and CRD.sessionSeqNum = ACD.sessionSeqNum and CRD.profileID = ACD.profileID</td>
<td>Use this statement: select * from CQD, ACD where CQD.sessionID = ACD.sessionID and CQD.sessionSeqNum = ACD.sessionSeqNum and CQD.profileID = ACD.profileID and CQD.nodeID = ACD.nodeID and CQD.qIndex = ACD.qIndex</td>
</tr>
</tbody>
</table>
Adding a 15-Minute Interval Length to a Cisco CRS Historical Report Filter Parameter

- Agent State Summary Report (by Agent)
- Agent State Summary Report (by Interval)
- Common Skill Contact Service Queue Activity Report (by Interval)

You can add a filter parameter that lets you display information for 15-minute intervals during the report period. To do so, follow these steps:

**Procedure**

**Step 1**
Locate the report definition file for the report that you want to update and make a backup copy of this file.

Report definition files have descriptive names and are located in the following folder under the folder in which you installed the Cisco CRS Historical Report client system (by default, the client system installs in the Program Files directory):

Cisco CRS Historical Reports\ReportTemplates\Language

For example, the report definition file for the U.S. English version of the Contact Service Queue Activity Report (by Interval) report is named:

ICD_Contact_Service_Queue_Activity_by_Interval_en_us.xml

By default, this file is located in this directory:

C:\Program Files\Cisco CRS Historical Reports\ReportTemplates\EN_us

**Step 2**
Use a Windows text editor to open the report definition file for the report that you want to update.

**Step 3**
In the report definition file, locate this line:

```xml
<ListOption OptionSelected="True" OptionValue="0">Entire report range</ListOption>
```

**Step 4**
Insert this line immediately after the line that you located:

```xml
<ListOption OptionSelected="False" OptionValue="15">Fifteen (15) minutes</ListOption>
```

Now there is a series of lines in the file that looks like this:

```xml
<ListOption OptionSelected="True" OptionValue="0">Entire report range</ListOption>
<ListOption OptionSelected="False" OptionValue="15">Fifteen (15) minutes</ListOption>
<ListOption OptionSelected="False" OptionValue="30">Thirty (30) minutes</ListOption>
<ListOption OptionSelected="False" OptionValue="60">Sixty (60) minutes</ListOption>
```
**Caveats**

This section includes the following topics:

- Using Bug Toolkit, page 32
- Known Limitation(s), page 33
- Open Caveats, page 39
- Closed Caveats, page 42

**Using Bug Toolkit**

If you are a registered Cisco.com user, you can find the latest information about resolved, open, and closed caveats for Cisco CRS by using Bug Toolkit, an online tool that allows you to query caveats according to your own needs. By using Bug Toolkit, you can find caveats of any severity for any release. Bug Toolkit may also provide a more current listing than this document provides.

To access Bug Toolkit, you need:

- Internet connection
- Web browser
- Cisco.com user ID and password
To use Bug Toolkit, follow these steps:

**Procedure**

**Step 1** Go to this URL to access the Bug Toolkit:

**Step 2** Log on with your Cisco.com user ID and password.

**Step 3** To access Cisco CRS caveats, take either of these actions:

* To access a particular caveat when you know its identifier, enter the identifier in the Search for Bug ID field and click Go.

* To access all caveats, follow these steps:
  a. From the Select Product Category list, choose Voice and Unified Communications.
  b. From the Select Product list, choose Cisco Unified Contact Center Express.
  c. From the Software Versions drop-down list, choose the desired Cisco CRS release.
  d. Click the desired Advanced Options radio button
     If you choose custom settings, enter appropriate custom information.
  e. Click Search.

A list of caveats that match your search criteria appear. To see details about any caveat, click its Bug ID number or click its Info link.

**Known Limitation(s)**

**Limitation 1**

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsz58742</td>
<td>Need to prevent scripts from being loaded when mem too high.</td>
</tr>
</tbody>
</table>
Problem
When there are a large number of applications configured, the engine runs out memory at or soon after startup. This is likely when there is a configuration such as the same script being used with many different applications, each with a separate trigger. This is due to the script being loaded into memory for each application configured.

Workaround
It is recommended that if such a scenario exists, the scripting features of reading application parameters from a common store, such as an XML file are used to configure a single application with that script, and associate multiple triggers to that single application. This will cause the script to only be loaded into memory once, greatly reducing memory usage.

For details, refer to the online record for the defect, CSCsz58742, using Bug Toolkit. This issue will be resolved in a future release or SR.

Resolved Caveats

Table 3 lists Severity 1, 2, and 3 defects that are resolved in this release of Cisco CRS.

For more information about an individual defect, you can access the online record for the defect by clicking the Identifier or going to the URL shown. You must be a registered Cisco.com user to access this online information.

Because defect status continually changes, be aware that Table 3 reflects a snapshot of the defects that were resolved at the time this report was compiled. For an updated view of resolved defects, access Bug Toolkit as described in the “Using Bug Toolkit” section on page 32.

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsb75577</td>
<td>CRS 4.5 installation stuck when removing backup files</td>
</tr>
<tr>
<td>CSCsb88320</td>
<td>Node recovery during restore prompts for reboot before recovering—Part 2</td>
</tr>
</tbody>
</table>
Table 3  Resolved Caveats (continued)

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsc60171</td>
<td>Title of the screen is corrupted in Cisco Agent Desktop client installer</td>
</tr>
<tr>
<td>CSCsc63563</td>
<td>Upload documentation step does not log error when upload fails</td>
</tr>
<tr>
<td>CSCsc65438</td>
<td>Unable to change codec by re-installing</td>
</tr>
<tr>
<td>CSCsc85283</td>
<td>JCUdateInstall displays: The account name field cannot be left blank</td>
</tr>
<tr>
<td>CSCsd36626</td>
<td>Transfer softkey shown when initiating conference with Cisco Agent Desktop</td>
</tr>
<tr>
<td>CSCsd54210</td>
<td>CRA 4.0 call stuck in queue using Call Consult Transfer step</td>
</tr>
<tr>
<td>CSCsd58731</td>
<td>Prompts with upper case file extension (.WAV) do not show up in the Prompt Management page</td>
</tr>
<tr>
<td>CSCsd66230</td>
<td>When restore fails, temporary folders for restore are not cleaned up</td>
</tr>
<tr>
<td>CSCsd66445</td>
<td>In Cisco CRS 4.0(4), after logout, can still access Appuser and Appsupervisor pages</td>
</tr>
<tr>
<td>CSCsd67516</td>
<td>CRA 4.0 SQL 2000 installs Microsoft Search service as automatic start</td>
</tr>
<tr>
<td>CSCsd78873</td>
<td>Blank page during JTAPI migration if JTAPI user is deleted from Cisco CallManager</td>
</tr>
<tr>
<td>CSCsd79065</td>
<td>WorkflowTask needs to be purged in addition to CSCsd78732</td>
</tr>
<tr>
<td>CSCsd79715</td>
<td>Bulk Spoken Upload tool does not work with CRS 4.x</td>
</tr>
<tr>
<td>CSCsd80752</td>
<td>Japanese characters are shown as question marks when coming from DB</td>
</tr>
<tr>
<td>CSCsd81792</td>
<td>ClusterManagerImpl in Editor needs to retrieve local registry</td>
</tr>
<tr>
<td>CSCsd83135</td>
<td>Cisco Agent Desktop does not install if the PC has Internet Explorer version 7</td>
</tr>
<tr>
<td>CSCsd85869</td>
<td>Proper message has to be given while activating Engine node on second active Directory setup</td>
</tr>
<tr>
<td>CSCsd86983</td>
<td>Upgrade fails to migrate recordings, upgrade tool displays error</td>
</tr>
<tr>
<td>CSCsd92109</td>
<td>Killing LDAP Monitor service results in CPU spike and possible blue screen</td>
</tr>
<tr>
<td>CSCsd94107</td>
<td>Cisco CRS Application Administration adds CTI ports incorrectly</td>
</tr>
<tr>
<td>CSCsd98903</td>
<td>Instructions for LDAP sync incorrect in Cisco Agent Desktop Service Information Guide</td>
</tr>
<tr>
<td>CSCSe01027</td>
<td>Cisco Agent Desktop shows incorrect call Total Time for RNA call</td>
</tr>
</tbody>
</table>
### Table 3  Resolved Caveats (continued)

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCse03410</td>
<td>Changing agent information while agent logged in corrupts historical reports</td>
</tr>
<tr>
<td>CSCse18726</td>
<td>Upgrade 3.5.3 to 4.0.4: CSQ report shows abandoned calls as dequeued</td>
</tr>
<tr>
<td>CSCse18751</td>
<td>Upgrade 3.5.3 to 4.0.4: number of calls handled decreases on CSQ reports</td>
</tr>
<tr>
<td>CSCse20368</td>
<td>Cisco Customer Response Solutions Historical Reporting Administrator and Developer Guide has incorrect information on custom call variables</td>
</tr>
<tr>
<td>CSCse21480</td>
<td>CRS CreateGeneratedPrompt plays back of dollar for US currency</td>
</tr>
<tr>
<td>CSCse30766</td>
<td>Editor does not work remotely when jar file is uploaded</td>
</tr>
<tr>
<td>CSCse38244</td>
<td>Upgrade fails due to SLCfgArchiveComponent</td>
</tr>
<tr>
<td>CSCse40038</td>
<td>Cisco CRS Application Administration ICM VRU Script problem</td>
</tr>
<tr>
<td>CSCse42142</td>
<td>License upgrade fails if duplicated server lines exist</td>
</tr>
<tr>
<td>CSCse47441</td>
<td>Telecaster user cannot change password/complexity in Active Directory</td>
</tr>
<tr>
<td>CSCse47483</td>
<td>Cluster profile gets duplicated when LDAP configuration is updated</td>
</tr>
<tr>
<td>CSCse49879</td>
<td>List of supported IP Phones in Cisco Agent Desktop Installation Guide should be updated</td>
</tr>
<tr>
<td>CSCse59817</td>
<td>Remove incorrect warning messages from SQL error logs</td>
</tr>
<tr>
<td>CSCse60610</td>
<td>LDAP monitor issue makes the agents get True update error</td>
</tr>
<tr>
<td>CSCse60951</td>
<td>Error message popping up while conferencing</td>
</tr>
<tr>
<td>CSCse62381</td>
<td>Migrate the agent personal employee phone book during an upgrade</td>
</tr>
<tr>
<td>CSCse62485</td>
<td>Support 40 ms frame size for media packets</td>
</tr>
<tr>
<td>CSCse62933</td>
<td>Resource configuration cannot be done for agent IDs having special characters</td>
</tr>
<tr>
<td>CSCse63244</td>
<td>Upgrade fail when there is a blank Cisco Agent Desktop phonebook entry</td>
</tr>
<tr>
<td>CSCse68653</td>
<td>Primary keys missing in tables in db_cra database</td>
</tr>
<tr>
<td>CSCse70861</td>
<td>Add checking for NULL into the PLACE CALL code in CRS</td>
</tr>
<tr>
<td>CSCse71018</td>
<td>Voice browser does not handle modal built in grammars correctly</td>
</tr>
<tr>
<td>CSCse71123</td>
<td>Cisco Desktop Administrator crashes when the maximum layouts of 16 reached in Enterprise Data</td>
</tr>
<tr>
<td>CSCse73377</td>
<td>Cisco Agent Desktop client agent.exe goes to 100% CPU utilization</td>
</tr>
<tr>
<td>CSCse76731</td>
<td>Debug of script with DBWrite step results in Object not Found exception</td>
</tr>
</tbody>
</table>
### Table 3  Resolved Caveats (continued)

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCse83848</td>
<td>Real-Time Reporting CSQ statistic does not show call as dequeued</td>
</tr>
<tr>
<td>CSCse87372</td>
<td>Install failure due to scripts missing <em>.aef</em> extension</td>
</tr>
<tr>
<td>CSCse89233</td>
<td>Application Summary report does not show all selected applications</td>
</tr>
<tr>
<td>CSCse90245</td>
<td>Garbled message pop up at Cisco Agent Desktop start up</td>
</tr>
<tr>
<td>CSCse90555</td>
<td>Null Pointer Exception while executing DBRead from the Editor</td>
</tr>
<tr>
<td>CSCse92070</td>
<td>Multi-stage upgrade losing seats information</td>
</tr>
<tr>
<td>CSCse94659</td>
<td>Setup does not check if LDAP configuration points to subscriber, resulting in bad upgrade</td>
</tr>
<tr>
<td>CSCse95054</td>
<td>Upgrade CRS: in BARS, server order list changes during upgrade</td>
</tr>
<tr>
<td>CSCse98604</td>
<td>Transfer non-existent call fails when ConnFailed event received</td>
</tr>
<tr>
<td>CSCse99031</td>
<td>CCDR record not written when agent is in work state then logs out</td>
</tr>
<tr>
<td>CSCsf00686</td>
<td>Historical Reporting cleanup does not write missing CCDR records</td>
</tr>
<tr>
<td>CSCsf05541</td>
<td>Error saving Agent Login Logout Activity report in CRS Historical Reporting</td>
</tr>
<tr>
<td>CSCsf06953</td>
<td>Redirect step causes Cisco Agent Desktop Transfer button to be replaced with Dial</td>
</tr>
<tr>
<td>CSCsf09352</td>
<td>Cisco Agent Desktop does not pop up for calls coming through the gateway</td>
</tr>
<tr>
<td>CSCsf11089</td>
<td>Filtering by route group on Agent Call Summary report returns All Resources</td>
</tr>
<tr>
<td>CSCsf11662</td>
<td>Agent goes to Not Ready state after making outbound call from Ready state</td>
</tr>
<tr>
<td>CSCsf16527</td>
<td>Calls stuck in queue due to race condition</td>
</tr>
<tr>
<td>CSCsf16679</td>
<td>CRS Installer should remind/prompt the user to run the Pre-Upgrade Check Tool</td>
</tr>
<tr>
<td>CSCsf18408</td>
<td>Cisco Agent Desktop, Cisco Supervisor Desktop site setup registry not updated after adding node to cluster</td>
</tr>
<tr>
<td>CSCsf18853</td>
<td>Agent Not Ready Reason Code Report error when using multiple filters</td>
</tr>
<tr>
<td>CSCsf19461</td>
<td>ContactTransferredEvent should contain consult sessionSeqNum</td>
</tr>
<tr>
<td>CSCsf21708</td>
<td>BARS restore stalls waiting for user to upgrade 3.x dedicated server</td>
</tr>
<tr>
<td>CSCsf26132</td>
<td>Cisco CRS Application Administration to check the DB Editor when customer activates high availability node</td>
</tr>
<tr>
<td>CSCsf27242</td>
<td>Cisco Agent Desktop agent call log shows N/A after upgrade</td>
</tr>
</tbody>
</table>

**Release Notes for Cisco Customer Response Solutions 4.0(5/5a)**
Table 3  Resolved Caveats (continued)

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsf27553</td>
<td>Need to update the process documented for rolling back a service release</td>
</tr>
<tr>
<td>CSCsf27694</td>
<td>Consult transfer reports success even when off-network destination does not answer</td>
</tr>
<tr>
<td>CSCsf29964</td>
<td>RM and RTDM out of sync, agent information for CSQs incorrect</td>
</tr>
<tr>
<td>CSCsf30145</td>
<td>Cisco CRS Application Administration does not properly show the reason why update is not allowed</td>
</tr>
<tr>
<td>CSCsf97649</td>
<td>CRS patch install instructions are unclear when referencing database server</td>
</tr>
<tr>
<td>CSCsf98369</td>
<td>Complex transfer scenario can result in incorrect agent state</td>
</tr>
<tr>
<td>CSCsg01029</td>
<td>Get Enterprise Data step does not convert correctly after upgrade</td>
</tr>
<tr>
<td>CSCsg03918</td>
<td>Reinstall of IPCC Express 4.0(4) SR1 causes errors</td>
</tr>
<tr>
<td>CSCsg03998</td>
<td>CRS install does not check whether server is not part of domain before upgrade</td>
</tr>
<tr>
<td>CSCsg05499</td>
<td>Documentation: Upgrading IPCC Express from version 3.1(2) to 4.0(4)9</td>
</tr>
<tr>
<td>CSCsg06441</td>
<td>Documentation: Need BARS 4.0.10 or later for CRS 4.0.4 upgrade</td>
</tr>
<tr>
<td>CSCsg08948</td>
<td>Step 1 of Replacing the Cisco CRS server in Installation Guide has wrong link</td>
</tr>
<tr>
<td>CSCsg08957</td>
<td>Add 3.x to 4.0 Upgrade alternative procedure that bypasses 3.x uninstall</td>
</tr>
<tr>
<td>CSCsg09279</td>
<td>Documentation: Naming convention for recorded files</td>
</tr>
<tr>
<td>CSCsg10430</td>
<td>Installation Guide falsely refer to Administration Guide for an unsupported procedure</td>
</tr>
<tr>
<td>CSCsg17807</td>
<td>Documentation does not specify whether you can have different versions</td>
</tr>
<tr>
<td>CSCsg28125</td>
<td>Error in output window from CRS4PreUpgradeCheck.bat</td>
</tr>
<tr>
<td>CSCsg31237</td>
<td>Cannot edit the Call Control Group with 10 digit directory</td>
</tr>
<tr>
<td>CSCsg32058</td>
<td>CRS 4.0 Pre-Upgrade Check Tool requires running from a command prompt</td>
</tr>
<tr>
<td>CSCsg32067</td>
<td>User must manually enter URL to check if CRS 4.0(4) upgrade will run</td>
</tr>
<tr>
<td>CSCsg32073</td>
<td>Browser is not able to download Java applets</td>
</tr>
<tr>
<td>CSCsg32085</td>
<td>Upgrade to CRS 4.0(4) requires publisher server to be running</td>
</tr>
<tr>
<td>CSCsg32101</td>
<td>This server belongs to a different cluster; you must uninstall Cisco CRS</td>
</tr>
<tr>
<td>CSCsg32106</td>
<td>CRS 4.0(4) upgrade hangs indefinitely on license file comparison</td>
</tr>
<tr>
<td>CSCsg32119</td>
<td>Upgrade License Conversion Tool does not auto-close</td>
</tr>
</tbody>
</table>
Table 3  Resolved Caveats (continued)

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsg32132</td>
<td>No reference to pop-up “This server belongs to a different cluster”</td>
</tr>
<tr>
<td>CSCsg37090</td>
<td>User prompted for the CRS 3.5 and 4.0 license path</td>
</tr>
<tr>
<td>CSCsg37094</td>
<td>User prompted for the CRS 4.0 license path</td>
</tr>
<tr>
<td>CSCsg37095</td>
<td>CRS Pre-Upgrade Check Tool does not auto-scroll to the last window display entry</td>
</tr>
<tr>
<td>CSCsg37097</td>
<td>Please initiate a backup of all the CRS server(s) using the Cisco Backup</td>
</tr>
<tr>
<td>CSCsg37098</td>
<td>Typo on install screen</td>
</tr>
<tr>
<td>CSCsg37100</td>
<td>Click OK when backup is done</td>
</tr>
<tr>
<td>CSCsg37102</td>
<td>Upgrade indication to perform restore is not intuitive</td>
</tr>
<tr>
<td>CSCsg37118</td>
<td>Now the system will restart; please continue with the setup</td>
</tr>
<tr>
<td>CSCsg37120</td>
<td>This node must be recovered; click Next to recover it</td>
</tr>
<tr>
<td>CSCsg37129</td>
<td>Documented Maximum AXL Writes Allowed per Minute value incorrect</td>
</tr>
<tr>
<td>CSCsg37130</td>
<td>CRS log collection is a manual operation</td>
</tr>
<tr>
<td>CSCsg37523</td>
<td>Cannot create CTI ports with a leading zero using Cisco CRS Application Administration</td>
</tr>
<tr>
<td>CSCsg43973</td>
<td>Typo in Cisco Customer Response Solutions Installation Wizard</td>
</tr>
<tr>
<td>CSCsg48077</td>
<td>CSQ Agent Summary Report does not sort by agent name</td>
</tr>
<tr>
<td>CSCsg48136</td>
<td>CSQ-Agent Report Missing RNA if agent handles 0 calls</td>
</tr>
<tr>
<td>CSCsg55597</td>
<td>CRS Engine in partial service while all services under Engine are in service</td>
</tr>
<tr>
<td>CSCsg73199</td>
<td>Documentation should state new profile name needed during re-install</td>
</tr>
<tr>
<td>CSCsh16920</td>
<td>Copyrights year not updated in CRS About and Help pages</td>
</tr>
</tbody>
</table>

### Open Caveats

Table 4 lists Severity 1, 2, and 3 defects that are open in this release of Cisco CRS. For more information about an individual defect, you can access the online record for the defect by clicking the Identifier or going to the URL shown. You must be a registered Cisco.com user to access this online information.
Because defect status continually changes, be aware that Table 4 reflects a snapshot of the defects that were open at the time this report was compiled. For an updated view of open defects, access Bug Toolkit as described in the “Using Bug Toolkit” section on page 32.

Table 4  Open Caveats

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsa88391</td>
<td>ICD report stops updating and does not respond if kept open for a few hours</td>
</tr>
<tr>
<td>CSCsd38512</td>
<td>ACDR with no matching CCDR for out of system then back in transfer</td>
</tr>
<tr>
<td>CSCsd42186</td>
<td>Incorrect CCD and CRD record linkage</td>
</tr>
<tr>
<td>CSCsd58815</td>
<td>Agent does not get any message while exiting the application</td>
</tr>
<tr>
<td>CSCsd6694</td>
<td>CRS Admin Utility—Serviceability Utility error—Empty node</td>
</tr>
<tr>
<td>CSCsd69608</td>
<td>Binding order of Cisco Telephony Operating System Windows 2000 has second NIC first</td>
</tr>
<tr>
<td>CSCsd70895</td>
<td>Add node2 after 3.x upgrade with group default language causes node2 invalid</td>
</tr>
<tr>
<td>CSCsd71976</td>
<td>Failed to upgrade after canceling install for several times</td>
</tr>
<tr>
<td>CSCsd73928</td>
<td>Speech server setup install: Setup initialization pop-up error 111</td>
</tr>
<tr>
<td>CSCsd79065</td>
<td>Installer to clean up workflow data during upgrade</td>
</tr>
<tr>
<td>CSCsd84209</td>
<td>Agent with user ID greater than 24 characters is not seen on Cisco Agent Desktop</td>
</tr>
<tr>
<td>CSCsd84491</td>
<td>Replication snapshot fails for CRSProperties with primary key violation</td>
</tr>
<tr>
<td>CSCse01600</td>
<td>Restore failed to restore configuration done from Cisco Desktop Administrator with special character</td>
</tr>
<tr>
<td>CSCse6416</td>
<td>Error in uploading zipped license file containing a sub-folder</td>
</tr>
<tr>
<td>CSCse15624</td>
<td>ArrayIndexOutOfBoundsException in the Repository layer</td>
</tr>
<tr>
<td>CSCse51070</td>
<td>Errors, and editor crashing</td>
</tr>
<tr>
<td>CSCse54564</td>
<td>Unable to login to Cisco CRS Application Administration or Historical Reporting client after Active Directory failover</td>
</tr>
<tr>
<td>CSCse79713</td>
<td>Historical Reporting Scheduler cannot print reports on printer behind print server</td>
</tr>
<tr>
<td>CSCse86950</td>
<td>Cisco CRS Application Administration should be case insensitive when new entries are created</td>
</tr>
</tbody>
</table>
## Caveats

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCse87304</td>
<td>SR3 installer for CRS 3.5(3) throws AutoIt Error / Runwait error</td>
</tr>
<tr>
<td>CSCsf18243</td>
<td>Cisco Supervisor Desktop barge, then intercept drops calls</td>
</tr>
<tr>
<td>CSCsf25410</td>
<td>CRS upgrade populates users with blank passwords in LDAP</td>
</tr>
<tr>
<td>CSCsf25773</td>
<td>JTAPI stuck on creating port during upgrade migration</td>
</tr>
<tr>
<td>CSCsg02563</td>
<td>Incorrect Cisco Agent Desktop version for IPCC Express in documentation</td>
</tr>
<tr>
<td>CSCsg13926</td>
<td>Documentation: Steps for configuring enterprise data for IP phone agent missing</td>
</tr>
<tr>
<td>CSCsg18832</td>
<td>Timestamp in logs does not match Windows time using (-6 GMT Mexico City)</td>
</tr>
<tr>
<td>CSCsg19498</td>
<td>Indications required for agents are not showing up in Resource page</td>
</tr>
<tr>
<td>CSCsg23031</td>
<td>Blind transfer causing problem</td>
</tr>
<tr>
<td>CSCsg24966</td>
<td>When LDAP is corrupted in Active Directory, the PATH of missing OU not shown</td>
</tr>
<tr>
<td>CSCsg31871</td>
<td>Agent stuck in Reserved state, multiple Select Resource steps for one contact</td>
</tr>
<tr>
<td>CSCsg32337</td>
<td>Rename function does not work in prompt management page</td>
</tr>
<tr>
<td>CSCsg40935</td>
<td>Uploading prompt ZIP file to repository larger than maximum gives no error</td>
</tr>
<tr>
<td>CSCsg58451</td>
<td>Cisco CallManager LDAP information section, Active Directory domain name does not work.</td>
</tr>
<tr>
<td>CSCsg63311</td>
<td>Updating Redirect CSS in JTAPI CallControlGroup does not take effect</td>
</tr>
<tr>
<td>CSCsg67618</td>
<td>Agents are not selected based on CSQ resource group criteria of linear</td>
</tr>
<tr>
<td>CSCsg71357</td>
<td>All call control groups are deleted when DCD refuses the connection to IPCC</td>
</tr>
<tr>
<td>CSCsg80300</td>
<td>Misleading error message when creating JTAPI provider</td>
</tr>
<tr>
<td>CSCsg84928</td>
<td>CTI ports do not register and JTAPI subsystem out of service</td>
</tr>
<tr>
<td>CSCsg90767</td>
<td>RingTime value intermittently incorrect in AgentConnectionDetail</td>
</tr>
<tr>
<td>CSCsg95726</td>
<td>Error while activating datastores during server setup</td>
</tr>
<tr>
<td>CSCsg96531</td>
<td>Multiple users making changes can create mutex lock issue</td>
</tr>
<tr>
<td>CSCsg96745</td>
<td>Call Pickup Group option on JTAPI trigger should be removed</td>
</tr>
<tr>
<td>CSCsg98024</td>
<td>CRS engine crashes with java.lang.OutOfMemoryError on 4.0(4)SR1</td>
</tr>
<tr>
<td>CSCsg98359</td>
<td>License update tool not updating to full 300 IVR ports</td>
</tr>
</tbody>
</table>
Caveats

Table 4  Open Caveats (continued)

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsg99597</td>
<td>Supervisor desktop statistics sorting report error</td>
</tr>
<tr>
<td>CSCsh16033</td>
<td>Clients using True Update to upgrade will fail if Internet Explorer 7 is installed</td>
</tr>
<tr>
<td>CSCsk15778</td>
<td>Current CRS time in Real-Time Reporting is not changing for NZ DST</td>
</tr>
</tbody>
</table>

Closed Caveats

Table 5  Closed Caveats

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Headline and Bug Toolkit Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSCsa75270</td>
<td>Color code in historical reports is not translated in specific languages</td>
</tr>
<tr>
<td>CSCsa78184</td>
<td>Tracking: Hiranaga/Katakana grammars do not work with ScanSoft MRCP</td>
</tr>
<tr>
<td>CSCsa81329</td>
<td>Caller hears fast busy after agent completes transfer using Task button on Cisco Agent Desktop</td>
</tr>
<tr>
<td>CSCsa83464</td>
<td>Non-SSML non-ASCII characters not played correctly</td>
</tr>
<tr>
<td>CSCsa91654</td>
<td>CDP driver service fails to start</td>
</tr>
<tr>
<td>CSCse68936</td>
<td>Using .after() or .before() with T[] variable does not work correctly.</td>
</tr>
<tr>
<td>CSCsg37137</td>
<td>User must manually stop and disable virus software prior to CRS upgrade</td>
</tr>
<tr>
<td>CSCsg48048</td>
<td>CSQ Agent Summary Report does not filter by agent name</td>
</tr>
</tbody>
</table>
Documentation Updates

The following sections provide documentation changes that were unavailable when the Cisco CRS 4.0(5) documentation was released:

- Documentation Updates for Cisco CRS Administration Guide, page 43
- Documentation Updates for Cisco CRS Installation Guide, page 49
- Documentation Updates for Cisco CRS Historical Reports User Guide, page 53
- Documentation Updates for Cisco Customer Response Solutions Historical Reporting Administrator and Developer Guide, page 53
- Documentation Updates for Cisco CRS Scripting and Development Series, page 66
- Documentation Updates for Cisco CRS Scripting and Development Series: Volume 1, Getting Started with Scripts, page 66
- Documentation Updates for Cisco Customer Response Solutions Servicing and Troubleshooting Guide, page 68

Documentation Updates for Cisco CRS Administration Guide

The following update applies to the “Provisioning Additional Subsystems” chapter:

In the “Defining an ODBC Data Source” section, the Note in Step 7 which currently reads as “When you want the workflow application script to read information from the db_cra CRS database, then select the Windows NT radio button as the authentication mode in a separate DSN. This choice provides read-only access to the db_cra database.” should be replaced with “CRS does not support configuring CRS and CCM databases as Enterprise DB servers.”

Other updates include:

- “Updates to the “Managing Prompts, Grammars, Documents, and Custom Files” Chapter” section on page 44
- Updates to the “Managing the Cisco CRS System” Chapter, page 44
Documentation Updates

- Updates to the “The Applications Menu” Chapter, page 47
- Updates to the “The Tools Menu” Chapter, page 48

Updates to the “Managing Prompts, Grammars, Documents, and Custom Files” Chapter

The following note applies to the “Managing Prompts, Grammars, Documents, and Custom Files” chapter:

If you receive the error “The page cannot be displayed” in Cisco CRS Administration when trying to upload a large prompt .wav file, manually move the file to the repository to resolve the issue.

Updates to the “Managing the Cisco CRS System” Chapter

The following update applies to the procedure in the “Migrating to a Different LDAP Directory” section in the “Managing the Cisco CRS System Chapter”:

- Insert this new step immediately after Step 3:
  Run the plug-in for the required directory in the Cisco CallManager Administration web page.

  See the Installing the Cisco Customer Directory Configuration Plug-in for Cisco CallManager Release 4.1(3) procedure at the following website:

  This website describes the Cisco CallManager migration process for DCD, AD, and ND.

- Remove Step 12.

The following sections replace the existing information in the “Examples: Updating Cisco CRS IP Address information” section in Chapter 8, “Managing the Cisco CRS System” of the Cisco CRS Administration Guide.

Scenario 1: Cisco CRS Collocated with Unified CallManager

In a deployment consisting of Cisco CRS collocated with Unified CallManager, do the following to update the IP address on the nodes in the cluster:

1. Stop the Cisco CRS Node manager from the Services window.
2. Use the Windows TCP/IP Properties window to modify the IP address of the machine.

3. Update the DNS server so that new IP address matches the old host name.

4. Assuming that the Unified CallManager IP address has changed, follow the instructions in the Unified CallManager user documentation for editing the IP address.

5. If you have Cisco IPCC Express, run the Cisco Agent Desktop Configuration Setup by double clicking the PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary CAD Directory Service, click OK.

You will get an error message "Error connecting to Directory Service. Do you want to try it again? The process may take time. Press Yes to retry Directory Service connection. Press No to proceed without Directory Service functionality." Click No in this dialog box. Then modify the IP address under the appropriate subsequent screens (such as Unified CallManager, VoIP Network Device and service IP address).

6. Launch the CRS Serviceability Utility and follow these steps:
   a. When launching the tool (assuming Unified CallManager is using DCD, if that is not the case then skip this step), it cannot connect to LDAP, as the Unified CallManager IP address is changed. A dialog box appears displaying the old connection details. Enter the new IP address and click Sync; the utility updates the LDAP server and ccndir.ini, and the tabs are populated with the data.
   b. Go to the Node Information tab and select the node for which the IP address has to be changed. Select the IP address from the drop-down list, enter the new IP address and click Update.

   Note You need to perform this step on all the nodes in the cluster.

   c. Go to the Unified CallManager LDAP tab, enter the new IP address, and click Update.
   d. Go to the Unified CallManager IP Address tab. Update RmCm JTAPI Provider and JTAPI Provider with the new IP address and click Update.
   e. Exit the Serviceability utility.

7. Reboot the Node.
8. If you have Cisco IPCC Express and you have configured IP Phone Agent (IPPA) service on Unified CallManager, access the Call Manager Administration page, update the URL in the IPPA service with new IP address, and click **Update subscriptions**.

**Scenario 3: Seven-Node Cluster**

In a seven-node cluster containing CRS on Node 1 and Node 2, VoIP on Node 3 and Node 4, RDB on Node 5 and Node 6, and Unified CallManager on Node 7, do the following to update the IP address on the nodes in the cluster:

1. Stop the CRS Node manager from the Services window on every node in the cluster.
2. Use the Windows TCP/IP Properties window to modify the IP address on all machines in the cluster.
3. Update the DNS server so that the new IP addresses to match old host names.
4. For Node 7 (CCM), follow the instructions as specified for Unified CallManager, assuming the Unified CM IP has changed.
5. For Node 1 (CRS), follow Scenario 1’s Steps 6.a, 6.b, 6.c, 6.d and 6.e.
6. If you have Cisco IPCC Express, run the Cisco Agent Desktop Configuration Setup by double clicking the PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary CAD Directory Service, click **OK**, you will get an error message "Error connecting to Directory Service. Do you want to try it again? The process may take time. Press Yes to retry Directory Service connection. Press No to proceed without Directory Service functionality." Click **No** in this dialog box. Then modify the IP address under the appropriate subsequent screens (such as Unified CM, VoIP Network Device and service IP address).
7. For Node 2 (CRS), follow Scenario 1’s Steps 6.a, 6.b, and 6.e.
8. For Node 3 (VoIP):
   a. Run the Cisco Agent Desktop Configuration Setup by double clicking the PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary CAD Directory Service, click **OK**.

   You will get an error message "Error connecting to Directory Service. Do you want to try it again? The process may take time."
Press Yes to retry Directory Service connection. Press No to proceed without Directory Service functionality.” Click No in this dialog box. Then modify the IP address under the appropriate subsequent screens (such as Unified CM, VoIP Network Device and service IP address).

b. Follow Scenario 1’s Steps 6.a, 6.b, and 6.e.

9. For Node 4 (VoIP)
   a. Run the Cisco Agent Desktop Configuration Setup by double clicking the PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary CAD Directory Service, click OK.

   You will get an error message “Error connecting to Directory Service. Do you want to try it again? The process may take time. Press Yes to retry Directory Service connection. Press No to proceed without Directory Service functionality.” Click No in this dialog box. Then modify the IP address under the appropriate subsequent screens (such as Unified CM, VoIP Network Device and service IP address).

   b. Follow Scenario 1’s Steps 6.a, 6.b, and 6.e.

10. For Node 5 (RDB), follow Scenario 1’s Steps 6.a and 6.e.

11. For Node 6 (RDB), follow Scenario 1’s Steps 6.a and 6.e.

12. Finally, reboot all the nodes.

**Updates to the “The Applications Menu” Chapter**

The following note applies to the “Prompt Management” section in the “The Applications Menu” chapter:

Note: You can use a custom script or the Cisco CRS Administration to upload a prompt.
Updates to the “The Tools Menu” Chapter

The following procedure replaces the wallboard set up procedure that is described in the “The Real-time Snapshot Config Menu Option” section in the “The Tools Menu” chapter:

Procedure

Step 1  On the wallboard client desktop, use the standard Windows Computer Management feature to create a new Windows NT account or a new local user, called CiscoWbUsr.

Make a note of the password for the new CiscoWbUsr account.

Step 2  On the Cisco CRS server, change the password for the CiscoWbUsr account to be the same as the password on the wallboard client desktop.

Step 3  From the wallboard client desktop, log in as CiscoWbUsr.

Step 4  Install the wallboard software on the wallboard client desktop.

Step 5  Create a system DSN on your Windows 2000 Professional or Windows 2000 server by choosing Start> Programs > Administrative Tools > Data Sources (ODBC).

The ODBC Data Source Administrator window opens.

Step 6  Click the System DSN tab and click Add.

The Create New Data Source window opens.

Step 7  In the Create New Data Source window, choose a SQL Server driver and click Finish.

The first Create a New Data Source to SQL Server window opens.

Step 8  In the first Create a New Data Source to SQL Server window, perform the following tasks:

a. In the Name field, specify a name for this DSN (for example, Wallboard.)

b. In the Description field, enter a descriptive name.

C. In the Which SQL Server field, enter CRSServer\CRSSQL.

Step 9  Click Finish.

The second Create a New Data Source to SQL Server window opens.
Step 10 In the second Create a New Data Source to SQL Server window, click the Windows NT server authentication radio button.

Step 11 Click Next.

The third Create a New Data Source to SQL Server window opens.

Step 12 In the third Create a New Data Source to SQL Server window, change the default database to db_cra and click Next.

The fourth Create a New Data Source to SQL Server window opens.

Step 13 In the fourth Create a New Data Source to SQL Server window, click Finish.

The ODBC Microsoft SQL Server window opens.

Step 14 In the ODBC Microsoft SQL Server window, click Test Data Source.

If the phrase Test completed successfully is returned, click OK.

If the test is unsuccessful, return to the configuration sequence and fix any errors.

---

**Documentation Updates for *Cisco CRS Installation Guide***

- The following update applies to the “Patching Cisco CRS” chapter:
  - In the “Before You Begin” section, include this as the first bullet:
    
    Restart/Reboot the Cisco CRS server on which you want to install the patch.

- The following update applies to the Verifying Hardware Settings and Connectivity section of the Installation and Upgrade Requirements, Prerequisites, and Related Procedures chapter:

  **Configuring Speed and Duplex Settings:**

  Step 5: Should read as ‘Set Speed and Duplex to Auto.’

- The following update applies to the Installation and Upgrade Requirements, Prerequisites, and Related Procedures chapter:

  Add a new section named “Guidelines for Deploying High Availability” as shown below:
Guidelines for Deploying High Availability

The following sections provide guidelines that you should follow if you deploy a Cisco CRS solution with high availability:

Guidelines for Deploying High Availability with Two Servers

If you are deploying high availability in an environment with two servers, perform the following general steps in this order.

**Note** If servers have different hard disk sizes, use the server with smaller disk as the active server and use the server with the larger disk as the standby server.

1. Install the Cisco CRS Engine, all the Datastore components, and Microsoft SQL Server 2000 on the server that will be the active server before you reboot the server.
2. Activate all Cisco CRS components on the active server
3. Install the Cisco CRS Engine, all the Datastore components, and Microsoft SQL Server 2000 on the server that will be the standby server before you reboot the server.
4. Activate all the components on the Standby server

Guidelines for Deploying High Availability with Four Servers

If you are deploying high availability in an environment with four servers, perform the general steps that are described in this section. Choose the method that suits your requirements.

**Note** If servers have different hard disk sizes, use the server with smaller disks as active servers and use the servers with the larger disks as the standby servers.
Method 1: Bring up a Call Center Quickly and Add High Availability Later
If you want to bring up your call center quickly, perform the following general steps in order shown. With this method, Cisco CRS starts without high availability and you add standby servers later.

1. Install the Cisco CRS Engine on the server that will be the active Engine server and activate the Cisco CRS Engine.
2. Install all Datastore components and Microsoft SQL Server 2000 on the server that will be the active database server before you reboot the server.
3. Activate the Datastore components on the active database server.
4. Install the Cisco CRS Engine on the server that will be the standby Engine server and activate the Cisco CRS Engine.
5. Install all Datastore components and Microsoft SQL Server 2000 on the server that will be the standby database server before you reboot the server.
6. Activate the Datastore components on the standby database server.

Method 2: Bring up a Call Center with High Availability Running
1. If you want to bring up your call center with high availability running, perform the following general steps in order shown. With this method, Cisco CRS starts with high availability, but the deployment takes longer than method 1.
2. Install the Cisco CRS Engine on the server that will be the active Engine server and activate the Cisco CRS Engine.
3. Install the Cisco CRS Engine on the server that will be the standby Engine server and activate the Cisco CRS Engine.
4. Install all Datastore components and Microsoft SQL Server 2000 on the server that will be the active database server before you reboot the server, then activate the database components on this server.
5. Install all Datastore components and Microsoft SQL Server 2000 on the server that will be the standby database server before you reboot the server, then activate the database components on this server.
Guidelines for Deploying Microsoft SQL Server 2000 with High Availability

When you deploy high availability, the following guidelines apply to Microsoft SQL Server 2000:

- Microsoft SQL Server 2000 must be installed on each server on which the Cisco CRS Datastore components are installed and activated. In a four-server deployment, it does not need to be installed on the servers on which the Cisco CRS Engine is installed.
- Complete the installation of MS SQL Server 2000 on a server before installing it on another server.
- Activate the Datastore components on a server after you install MS SQL Server 2000 on the server.
- If you are changing from a deployment without high availability to a deployment with high availability, first install MS SQL Server 2000 and configure the Datastore components on an existing server. Then install MS SQL Server 2000 and configure the Datastore components on the standby server.

The following update applies to the “Upgrading Cisco CRS 3.x to Cisco CRS 4.0(5) in a Single-Server Deployment” Chapter in Cisco CRS Installation Guide:

- In the “Upgrading Cisco CRS section, the message shown in Step 20 should include the text “select server_name or IP address as the data destination server” instead of “select server_name as the data destination server.”
- In the “Patching Cisco CRS” chapter, add this note:
  Running BARS using terminal services or VNC is not supported.
Documentation Updates for *Cisco CRS Historical Reports User Guide*

The following change applies to the “The hrcConfig.ini Configuration File” section in *Cisco CRS Historical Reports User Guide*:

To change the defaultExportPath parameter in the hrcConfig.ini configuration file for the Cisco CRS Historical Reports Client, follow these guidelines:

- Make sure that the new directory exists on the shared drive.
- Enclose the new path in quotation marks. For example:

  ```plaintext
defaultExportPath="\209.165.200.225\F$\CRS_REPORTS"
  ```

Documentation Updates for *Cisco Customer Response Solutions Historical Reporting Administrator and Developer Guide*

This section includes these updates to *Cisco Customer Response Solutions Historical Reporting Administrator and Developer Guide*:

- Updates to “Historical Reports Query Designs” Chapter, page 53
- Updates to “Creating Custom Historical Reports for Cisco Customer Response Solutions” Chapter, page 54
- Updates “Frequently Asked Questions” Chapter, page 65

**Updates to “Historical Reports Query Designs” Chapter**

The description of the Total Incoming Calls field in the “Traffic Analysis Report” section in the “Historical Reports Query Designs” chapter should say:

For each day, count the number of CCD records with a unique sessionID with the contactType field set to any value.
Updates to “Creating Custom Historical Reports for Cisco Customer Response Solutions” Chapter

The following changes apply to the “Creating Custom Historical Reports for Cisco Customer Response Solutions” chapter:

- **New Section:** “Before you Begin”, page 54—This new subsection should be the first one in the “Creating a Report” section.

- **Revised Section:** “Creating a Report using Crystal Reports Version 8.5”, page 56—This new subsection and “Creating a Report using Crystal Reports Version 10” replace the “Creating a Report” section.

- **Revised Section:** “Creating a Report using Crystal Reports Version 10”, page 60—This new subsection and “Creating a Report using Crystal Reports Version 8.5” replace the “Creating a Report” section.

**New Section: “Before you Begin”**

This new sub-section should be the first one in the “Creating a Report” section.

Before you create a new report, perform these steps:

- Write a SQL stored procedure to join database tables and calculate the data that the report requires. Refer to *Cisco Customer Response Solutions Database Schema* for information about the Cisco CRS database tables.

- Copy the following files from the Cisco CRS Historical Reports folder on the Cisco CRS Historical Reports client system to the C:\Program Files\Seagate Software\Crystal Reports 85 or to the C:\Program Files\Crystal Decisions\Crystal Reports 10 folder:
  - Cal.dll
  - Cal.ini
  - CiscoAppsReports_*_.dll
  - hrcConfig.ini
  - launchHRC.exe
Create a shortcut to crw32.exe. The crw32.exe file resides in the same folder to which you copied the files above. Then right-click the shortcut, choose Properties, and enter the following text in the Target field. (Make sure to include the quotation marks.)

- For Crystal Reports version 8.5: “C:\Program Files\Seagate Software\Crystal Reports\launchHRC.exe” crw32.exe
- For Crystal Reports version 10: “C:\Program Files\Crystal Decisions\Crystal Reports 10\launchHRC.exe” crw32.exe

You must use this shortcut when you start Crystal Reports as described in the “Creating a Report using Crystal Reports Version 8.5” section.

From the Windows Control Panel:

a. Choose Administrative Tools > Data Sources (ODBC).
b. In the ODBC Data Source Administrator window, click the System DSN tab, and then click Add.
c. In the Create New Data Source window, choose SQL Server from the Name list and click Finish.
d. In the Create New Data Source to SQL Server window:
   - In the Name field, enter a name for the data source.
   - In the Server field, enter the host name or the IP address of the server that stores the reporting data and the reporting stored procedures. You must append the named instance to the server name. For example, if the server name is CRAHRSRV, and the named instance is \CRSSQL, enter CRAHRSRV\CRSSQL in this field.
   - Click Next.
e. In the Create a New Data Source to SQL Server window, make sure that the With Windows NT authentication using the network login ID radio button is selected, and then click Client Configuration.
f. In the Add Network Library Configuration window:
   - In the Network libraries pane, click the TCP/IP radio button.
   - In the Connection parameters pane, uncheck the Dynamically determine port check box.
   - In the Port number field, enter 4433.
   - Click OK.
g. In the Create a New Data Source to SQL Server window:
   - Uncheck this check box: Connect to SQL Server to obtain default
     settings for the additional configuration options.
   - Click Next.

h. Click Next and Finish as needed to exit the windows.

Note
If you choose to test the data source, the system will display an error message.

Revised Section: “Creating a Report using Crystal Reports Version 8.5”

Refer to this section if you are creating a new report using Crystal Reports version 8.5
This section describes how to create a new report using Crystal Reports version 8.5. For instructions about how to create a report using Crystal Reports version 10, see the “Creating a Report Using Crystal Reports Version 10” section.

To create a new report, use Crystal Reports version 8.5 Professional or Developer Edition, a generally available third-party application, to create two versions of the report. The versions should be identical, except that one version should contain charts.

Tip
Build the report with charts first and save it with the appropriate name for a report with charts as explained in Step 12. Then, delete the charts and save the modified report with the appropriate name for a report without charts as explained in Step 12.

For more information about creating reports with Crystal Reports, refer to your Crystal Reports documentation. For information about the tables and records in the Cisco CRS database, refer to Cisco Customer Response Solutions Database Schema.

To create a new report using Crystal Reports version 8.5, perform the following procedure. Make sure to follow the steps that are described in the “Before you Begin” section before you perform this procedure.
Procedure

Step 1  Use the shortcut that you created as described in the “Before you Begin” section to start Crystal Reports, and then choose **File > New**.

The Welcome to Crystal Reports window appears.

Step 2 In the Welcome to Crystal Reports window, click the **Using the Report Expert** radio button and then click **OK**.

The Crystal Reports Gallery window appears.

Step 3 In the Crystal Reports Gallery window make sure that **Standard** is highlighted in the Choose an Expert area, and then click **OK**.

The Standard Report Expert window appears.

Step 4 In the Standard Report Expert window:
   a. Click **Database** in the Data tab.
   b. Click **Next**.

The Data Explorer window appear.

Step 5 In the Data Explorer window:
   a. Expand **More Data Sources**.
   b. Expand **Active Data**.
   c. Click **Active Data (ADO)**.
   d. Click **Add**.

The Select Data Source window appears.

Step 6 In the Select Data Source window:
   a. Click the **ODBC (ADO)** radio button.
   b. From the ODBC (ADO) drop-down list, choose the name of the data source (DSN) that you created as described in the “Before you Begin” section.
   c. Click **OK**.

The Data Explorer window appears.
Step 7 In the Data Explorer window:
   a. Click ado under the name of the data source (DSN) that you created.
   b. Click Add.
      The Select Recordset window appears.
Step 8 In the Select Recordset window:
   a. Click the SQL radio button.
   b. Enter the command to execute the stored procedure that you created as described in the “Before you Begin” section.
   c. Click OK.
Step 9 In Data Explorer window, click Close.
Step 10 In the Standard Report Expert window, click the Fields tab and verify that the fields written by your stored procedure appear in the Available Fields list.
Step 11 Follow the directions in your Crystal Reports documentation to complete setting up the report.
Step 12 Save the report in the following directory under the directory in which you installed the client system. (By default, the client system installs in the Program Files directory.) Replace Language with the name of the appropriate language directory.
   Cisco CRS Historical Reports\Report Templates\Language
   Name the report as follows:
   Category_ReportDisplayName_ReportFormat_Locale.rpt
   Replace Category, ReportDisplayName, ReportFormat, and Locale with appropriate values as explained in Table 6.
## Table 6  File Name Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Explanation</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Cisco CRS application package with which to associate this report. Users</td>
<td><strong>CCR</strong>—IPCC Express Enhanced or IPCC Express Premium</td>
</tr>
<tr>
<td></td>
<td>with access to this package will be able to generate this report.</td>
<td><strong>ICD</strong>—IPCC Express Standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>IVR</strong>—IP IVR</td>
</tr>
<tr>
<td>ReportDisplayName</td>
<td>You can use any name. This name will be replaced with the name specified by</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>vFileName in the reports catalog file line that you add for this report.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If a name has more than one word, separate each word with an underscore.</td>
<td></td>
</tr>
<tr>
<td>ReportFormat</td>
<td>Whether the report includes charts.</td>
<td><strong>Chart</strong>—Report includes charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Table</strong>—Report does not include charts</td>
</tr>
<tr>
<td>Locale</td>
<td>Locale ISO string. Specifies the language in which you created the field</td>
<td>Languages installed on the Cisco CRS</td>
</tr>
<tr>
<td></td>
<td>names, headings, and other static items in the report. Consists of an ISO</td>
<td>Historical Reports client system. For example:</td>
</tr>
<tr>
<td></td>
<td>language code followed by an underscore (_) and then an ISO country code.</td>
<td><strong>en_US</strong>—English</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>de_DE</strong>—German</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>es_ES</strong>—Spanish</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>fr_FR</strong>—French</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>it_IT</strong>—Italian</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>ja_JP</strong>—Japanese</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>zh_CN</strong>—Simplified Chinese</td>
</tr>
<tr>
<td></td>
<td>To see the languages installed on the client system, look at the folder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>names in the Cisco CRS Historical Reports\Report Templates directory.</td>
<td></td>
</tr>
</tbody>
</table>
The following is an example of a report name:
CCR_My_New_Report_Chart_en_us.rpt
In this example:

- Users who have access to the Cisco IPCC Express Enhanced application package will be able to generate this report.
- The report will appear as My New Report in the Report Type drop-down list on the Cisco CRS Historical Reports main window.
- The report includes one or more charts.
- The report is designed to run on a system with a system locale of English.
- The extension .rpt indicates that this file is a report file.

Now you are ready to create a report definition file as described the “Creating a Report Definition File” section.

Revised Section: “Creating a Report using Crystal Reports Version 10”

Refer to this section if you are creating a new report using Crystal Reports version 10

This section describes how to create a new report using Crystal Reports version 10. For instructions about how to create a report using Crystal Reports version 8.5, see the “Creating a Report using Crystal Reports Version 8.5” section.

To create a new report, use Crystal Reports version 10 Professional or Developer Edition, a generally available third-party application, to create two versions of the report. The versions should be identical, except that one version should contain charts.

Tip
Build the report with charts first and save it with the appropriate name for a report with charts as explained in Step 14. Then, delete the charts and save the modified report with the appropriate name for a report without charts as explained in Step 14.

For more information about creating reports with Crystal Reports, refer to your Crystal Reports documentation. For information about the tables and records in the Cisco CRS database, refer to Cisco Customer Response Solutions Database Schema.
To create a new report using Crystal Reports version 10, perform the following procedure. Make sure to follow the steps that are described in the “Before you Begin” section before you perform this procedure.

**Procedure**

**Step 1**  
Use the shortcut that you created as described in the “Before you Begin” section to start Crystal Reports and choose **File > New**.  
The Welcome to Crystal Reports window appears.

**Step 2**  
In the Welcome to Crystal Reports window, click the **Using the Report Wizard** radio button and then click **OK**.  
The Crystal Reports Gallery window appears.

**Step 3**  
In the Crystal Reports Gallery window make sure that **Standard** is highlighted in the Choose a Wizard area, and then click **OK**.  
The Standard Report Creation Wizard window appears.

**Step 4**  
In the Standard Report Creation Wizard available Data Sources pane, take either of these actions:

- If Crystal Reports is installed on a computer that belongs to a domain, expand Create New Connection, and then click **ODBC (RDO)**.  
The Data Source Selection window appears.  
Continue to **Step 5**.

- If Crystal Reports is installed on a computer that belongs to a workgroup, go to **Step 7**.

**Step 5**  
In the Data Source Selection window:

a. From the Data Source Name list, chose the data source that you created as described in the “Before you Begin” section.

b. Click **Next**.  
The Connection Information window appears.
Step 6  In the Connection Information window:
   a. Check the Trusted Connection check box.
   b. Click Finish.

Step 7  In the Standard Report Creation Wizard Data window, expand OLE DB (ADO).
The OLE DB (ADO) window for selecting an OLD DB Provider window appears.

Step 8  In the OLE DB (ADO) window for selecting an OLD DB Provider:
   a. Click Microsoft OLE DB Provider for SQL Server to highlight it.
   b. Click Next.

Step 9  In the OLE DB (ADO) window for providing connection information:
   a. In the Server field, enter the host name or the IP address of the server that
      stores the reporting data and the reporting stored procedures.
      You must append the named instance to the server name. For example, if the
      server name is CRAHRSRV, and the named instance is \CRSSQL, enter
      CRAHRSRV\CRSSQL in this field.
   b. In the Database field, choose the database that contains the reporting stored
      procedures.
   c. Check the Integrated Security check box.
   d. Click Next.

Step 10 In the OLE DB (ADO) window for providing advanced information:
   a. Change values, if needed.
      Refer to your Crystal Reports documentation for more information.
   b. Click Finish.

Step 11 In the Standard Report Creation Data window for choosing data:
   a. In the Available Data Sources pane, navigate to and expand the Stored
      Procedures for the database that you created as described in the “Before you
      Begin” section.
   b. Click the stored procedure that you want to use.
   c. Click Next
**Step 12** In the Enter Parameter Values window:

a. Specifying the input parameter values that you want.

b. Click OK.

**Step 13** Follow the directions provided by the Crystal Reports wizard to complete setting up the report.

Refer to your Crystal Reports documentation for more information.

**Step 14** Save the report in the following directory under the directory in which you installed the client system. (By default, the client system installs in the Program Files directory.) Replace *Language* with the name of the appropriate language directory.

Cisco CRS Historical Reports\Report Templates\*Language

Name the report as follows:

*Category_ReportDisplayname_ReportFormat_Locale*.rpt

Replace *Category*, *ReportDisplayname*, *ReportFormat*, and *Locale* with appropriate values as explained in Table 7.

---

**Table 7 File Name Components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Explanation</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Cisco CRS application package with which to associate this report. Users with access to this package will be able to generate this report.</td>
<td>CCR—IPCC Express Enhanced or IPCC Express Premium ICD—IPCC Express Standard IVR—IP IVR</td>
</tr>
<tr>
<td>ReportDisplayName</td>
<td>You can use any name. This name will be replaced with the name specified by vFileName in the reports catalog file line that you add for this report. If a name has more than one word, separate each word with an underscore.</td>
<td>—</td>
</tr>
</tbody>
</table>
The following is an example of a report name:

CCR_My_New_Report_Chart_en_us.rpt

In this example:

- Users who have access to the Cisco IPCC Express Enhanced application package will be able to generate this report.
- The report will appear as My New Report in the Report Type drop-down list on the Cisco CRS Historical Reports main window.
- The report includes one or more charts.
- The report is designed to run on a system with a system locale of English.
- The extension .rpt indicates that this file is a report file.
Now you are ready to create a report definition file as described the “Creating a Report Definition File” section.

Updates “Frequently Asked Questions” Chapter

The following changes apply to the “Frequently Asked Questions” chapter in Cisco CRS Historical Reports User Guide:

- **Question** - What does it mean when the contact disposition is 3?
  - **Answer** - When the system cleans up a call, which may have remained in the system because of missing events, the system writes a CCDR with the contact disposition dont_care (value = 3).

- In the following scenarios, more than one record can have the same Node ID, Session ID, and Sequence No:
  - A call is conferenced to a CTI route point
  - A call goes RNA (ring no answer) to an agent.

- The following steps replace the current Step 4 through Step 8 in the answer to “Is there a way to report on menu choices?”:
  
  New Step 4: Define a Menu step that has three branches and place a Set Enterprise Call Info step in each branch.
  
  New Step 5: In the General tab of the Set Enterprise Call Info step, click Add.
  
  New Step 6: In the branch for caller-choice 1, enter 1 in the Value field, and choose Call.PeripheralVariable1 from the Name drop-down list.
  
  New Step 7: In the branch for caller-choice 2, enter 2 in the Value field, and choose Call.PeripheralVariable2 from the Name drop-down list.
  
  New Step 8: In the branch for caller-choice 3, enter 3 in the Value field, and choose Call.PeripheralVariable3 from the Name drop-down list.

- The following note applies to the answer to “How can a report on reason codes be generated?”:
  
  Not Ready codes are system wide and you cannot configure it to be hidden from certain agents.
Documentation Updates for *Cisco CRS Scripting and Development Series*

The following information applies to *Cisco CRS Scripting and Development Series* documents:

**About Expressions and Java Licensing**

In CRS 4.x, Java expressions are validated against installed licenses to make sure that they do not violate license agreements. This validation is performed by the CRS Engine whenever a script is loaded or whenever a prompt template or grammar template is accessed and evaluated.

In IP IVR, IP Queue Manager, IPCC Express Enhanced, and IPCC Express Premium, you can enter both simple and complex expressions.

However, in IPCC Express Standard, you can enter only simple expressions unless you also have a Java license. You automatically have a Java license with the other four CRS products.

An example of a TTS feature is a TTS prompt complex literal. A Java feature is a complex expression block, a Java-like statement, method, constructor invocation expression, or a field access expression.

Any license violation will be recorded in the logs and prevent the scripts from being loaded in memory.

**Documentation Updates for Cisco CRS Scripting and Development Series: Volume 1, Getting Started with Scripts**

- *Cisco CRS Scripting and Development Series: Volume 1, Getting Started with Scripts* describes the “com.cisco.dtmf.termlength” property. However, Cisco CRS does not support this property.

- The following information applies when you use the Place Call Step as described in the "Working with Multiple Contacts” chapter:

  If the RNA timeout in the script is longer than the CFNA timer of Cisco CallManager, the agent phone goes to Not Ready state after a ring-no-answer. To resolve this issue, change the timeout value in the script to a lower than the CFNA in Cisco CallManager.
The following information applies to the description of the Call Redirect Step in the “Designing an IP IVR Script” chapter:

Adding a 2 second delay is a best practice when you have a script that performs a transfer or redirect to another script. Without the delay, there will be a timing issue. When a transfer or redirect occurs, a call leg is initiated. If the transfer or redirect completes and then another transfer or redirect occurs, the call leg from the second transfer or redirect can get stuck. In this case, the second transfer or redirect fails. Adding a delay ensures that the second transfer or redirect leg can complete before continuing through the script.

The following information applies in a Cisco CRS deployment with high availability when you develop a script that references XML applications:

The XML files must be stored on both the active and the standby server and in the same location (path name and folder name) on each server. The XML files are not automatically replicated between servers. Any changes must be made to the files on both servers. Alternatively, you may use the Document Management utility, which does provide replication between servers when the servers are synchronized.

Documentation Updates for *Cisco CRS Scripting and Development Series: Volume 2, CRS Editor Step Reference Guide*

You should not pass more than 40 characters in a call variable that is used in the Set Enterprise Call Info step because the database in which the call variables are stored limits the length of the call variables to 40 characters each.

Though the number of characters that you can pass in a custom call variable of the Set Enterprise Call Info Step is unlimited, if you include more than 40 characters, the extra characters are lost when the variables are stored in the database. In this case, reports will not contain that additional information.
Documentation Updates for Cisco Customer Response Solutions Servicing and Troubleshooting Guide

The following new Step 11 should be added to the “General Troubleshooting Steps” section in the “Diagnosing and Correcting Cisco CRS Problems” chapter:

Step 11. Verify that there is network connectivity to the CRA server.

Documentation Updates for Cisco Customer Response Solutions Servicing and Troubleshooting Guide

- The following new Step 11 should be added to the “General Troubleshooting Steps” section in the “Diagnosing and Correcting Cisco CRS Problems” chapter:
  
  Step 11. Verify that there is network connectivity to the CRA server.

- The following note should be added to the “JTAPI subsystem is in partial service” troubleshooting tip:

  If a failure occurs during JTAPI migration process from CRS 3.5, a CTI port group may have only a subset of the CTI ports migrated. This situation can result in JTAPI subsystem being in partial service. In this case, go to the JTAPI Subsystem Configuration page in Cisco CRS Administration, then delete and recreate the CTI port group.

- The “Calling party and CRA do not have common codec” in the “CRA Engine Problems” section should include this message as a symptom:

  CTIERR_REDIRECT_CALL_MEDIA_CONNECTION_FAILED=0x8ccc0036

- The following section should be added to the “Cisco CRS Administration Problems” section:

  Callers hear a fast busy while calling the JTAPI triggers

  Symptom: While calling the JTAPI triggers, callers hear a fast busy and the following message appears in the MIVR log:

  %MIVR-SS_TEI-7-UNK:Call.rejected(TRIGGER_MAX_SESSION)
Recommended Action:
1. Delete and then add back the trigger.
2. Restart CRS node manager.

- The following information applies to the “CRS Engine Problems” section:
  It is normal for the following CRS subsystems to be in Partial service if the subsystems are not configured. They will only be in service if you have configured the server to use them.
  - Database subsystem—In service only if you have configured an external database for something such as a database dip when a call come in.
  - MRCP ASR subsystem—In service only if you have configured an automatic speech recognition (ASR) system for use with Cisco CRS.
  - MRCP TTS subsystem—In service only if you have configured a text to speech (TTS) system for use with Cisco CRS.
  - VOIP Monitor subsystem—In service only if you have completely configured monitoring and recording on your server for monitoring and recording of agents.

Obtaining Documentation, Obtaining Support, and Security Guidelines

For information about obtaining documentation, obtaining support, providing documentation feedback, security guidelines, and recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:
